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October 29, 2004
Introduction to Cisco 
Desktop Administrator
Introduction

Cisco Desktop Administrator is a “container” program. It allows you to access 
various other applications used to administer Cisco Agent Desktop and Cisco 
Supervisor Desktop from within one interface. 

NOTE:  Desktop Administrator does not support Agent Desktop and 
Supervisor Desktop if the users of those applications are on a virtual 
private network (VPN).

Desktop Administrator Versions

Desktop Administrator is available in two versions: Standard and Enhanced. 

■ Enhanced Desktop Administrator includes all the functions described in 
this manual.

■ Standard Desktop Administrator does not allow you to customize the 
Agent Desktop interface or to automate work flows. 
1-1
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About This Document

Intended Audience
This document is written for contact center system administrators who use Cisco 
Desktop Administrator.

Conventions
In this document, terminology and typographic conventions are as follows:

Terminology

■ The word enter means to press the sequence of keys specified. For 
example, an instruction to enter the letter “y” is shown as

Enter y to continue.

■ The word click means to use your mouse to execute the action 
represented by a button. For example, an instruction to click the Next 
button is shown as 

Click Next.

■ The words check and uncheck mean to activate or deactivate a check box. 
For example, an instruction to deactivate the Dial Number as Entered 
check box is shown as

Uncheck the Dial Number as Entered check box.

■ The word choose means to pick an option from a menu or submenu. For 
example, an instruction to choose the Desktop option from a series of 
submenus is shown as

Choose Start > Programs > Cisco > Desktop.

■ The word select means to mark text or other elements to be copied or cut. 
For example, an instruction to select text is shown as 

Select an entry from the list to edit.

■ Simultaneous keystrokes (as when you hold down the first key, then press 
the second and third keys) are represented as a series of bolded key 
names joined by hyphens. For example, an instruction to press and hold 
the Alt key while pressing the letter “d” is shown as

Press Alt-d

■ Function keys are represented by the letter F followed by the function key 
number. For example, an instruction to press function key 3 is shown as

Press F3.
1-2 October 29, 2004



About This Document
Typography

■ Commands and text you type, and the names of windows, buttons, menus, 
and menu options appear in bold type:

From the Options menu, choose Local Admin.

■ Variables you must enter appear in italics:

http://servername/appadmin

■ Terms that are being defined appear in italics:

Actions are commands that perform a task.

■ Menu paths appear in bold type with menu options separated by right 
angle brackets:

Choose Options > Status Bar.
October 29, 2004 1-3
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The Desktop Administrator Interface

The Desktop Administrator interface has two panes. The left pane is a navigation 
tree similar to that found in Windows Explorer. The right pane displays the 
application that you choose in the left pane. 

Figure 1-1. The Desktop Administrator interface. In this example, the Phone Book 
node is selected in the left pane and displayed in the right pane.

The root of the navigation tree is Locations. Underneath Locations is a list of the 
logical contact centers set up in your system. Underneath each logical contact 
center is a list of the applications that administer Agent Desktop and Supervisor 
Desktop for that logical contact center.

NOTE:  When you select a node on the navigation tree, the menu bar and 
toolbar of Desktop Administrator change to reflect the design of that 
node’s application. 

Navigation Tree Pane Navigation

Use these mouse or keyboard actions in the left pane to navigate the tree.

Mouse
■ Double-click an icon/application name to expand or collapse the tree.
■ Click the plus sign ( + ) to expand the tree.
■ Click the minus sign ( – ) to collapse the tree.
■ Right-click to rename or delete a node (not available for all nodes).
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The Desktop Administrator Interface
Keyboard
With a node selected,

■ Press the up and down arrow keys to move from one node to the next.
■ Press the left arrow key to collapse the tree.
■ Press the right arrow key to expand the tree.
■ Press F2 to rename an icon (not available for all nodes).

Display Pane Navigation

The applications displayed in the right pane are designed to use shortcut keys 
and the tab key as alternatives to using the mouse to navigate around a window. 
In this version of Desktop Administrator, however, the shortcut keys and tab key 
are not functional. It is recommended that you rely on the mouse to navigate 
around a window.
October 29, 2004 1-5
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User Privileges in Windows NT and 
Windows 2000

Because Desktop Administrator users must be able to update registry settings, 
they must have Administrator or Power User privileges on Windows NT and 
Windows 2000 platforms. 

Only a person with Administrator privileges can change user privileges on the 
Administrator PC if it is necessary to upgrade them.
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Passwords

Desktop Administrator

A password is optional for Desktop Administrator. If you choose to use a 
password, the password applies only to the Desktop Configuration application 
within Desktop Administrator. 

If you choose the Desktop Configuration node and the password function is 
enabled, you will be prompted to provide the password. 

Your password should remain confidential. If it becomes known, change it.

To set up a password:

1. In the navigation pane, select the Desktop Configuration node or any node 
underneath it.

2. From the File menu, choose Change Cisco Desktop Administrator 
Password.

The Change Cisco Desktop Administrator Password dialog box appears. 
(See Figure 1-2.)

Figure 1-2. Change Password dialog box. If you are setting up a new password, the 
Old Password field is disabled.

3. Enter a new password, type it again to confirm it, and then click OK.

Passwords are case sensitive and may consist of up to a maximum of 32 
alphanumeric characters.

The Desktop Configuration node is now password protected.
October 29, 2004 1-7
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To change your password:

1. In the left pane, select the Desktop Configuration node or any node 
underneath it.

2. From the File menu, choose Change Cisco Desktop Administrator 
Password.

The Change Cisco Desktop Administrator Password dialog box appears. 
(see Figure 1-2.)

3. Enter your old password, a new password, and your new password again 
to confirm it, and then click OK.

Your Desktop Configuration password is now changed.

NOTE:  If you forget your password, you must reinstall Desktop 
Administrator.

Agent Desktop and Supervisor Desktop 
User IDs and Passwords

Agent Desktop

Agent Desktop user IDs and passwords are set up in CallManager and can be 
administered only through CallManager. The user’s Agent Desktop password is 
verified on the CTI server when a user starts Agent Desktop.

Use CallManager to change a user’s Agent Desktop password if it becomes 
necessary to do so.

Supervisor Desktop

A user’s Supervisor Desktop user ID and password are the same as the user’s 
Agent Desktop user ID (the user ID, as set up in CallManager, is used in both the 
user ID and password fields). User IDs and passwords are verified in Directory 
Services when the user starts Supervisor Desktop.

The only way to change a Supervisor Desktop password is to issue the user a 
new Agent Desktop user ID in CallManager. 
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CTI Server Configuration and 
Directory Services Synchronization

From the Locations node level in the Navigation pane, you can configure the CTI 
server and synchronize the agent database between the ICD server and the 
Directory Services server. 

Configuring the CTI Server

To configure the CTI server:

1. Select the Locations node in the left pane.

2. From the Setup menu, choose CTI Server.

The Server Configurations dialog box appears. (See Figure 1-3.)

Figure 1-3. Server Configuration dialog box.

3. Enter the host name or IP address and port numbers of the CTI server you 
are using, and then click OK.

The host name/IP address and port number of the CTI server are set.

Synchronizing Directory Services

The ICD agent database is the master database. The Directory Services 
database should mirror the ICD agent database. You can synchronize the agent 
database between the ICD server and the Directory Services server with the 
Synchronize Directory Services command.

You can program the synchronization function to perform automatically (for 
instance, once a minute) by changing a setting in the DirAccessSynSvr.cfg file 
(refer to Cisco Desktop Product Suite 4.5 Service Information, Chapter 3), or 
you can synchronize the databases manually.
October 29, 2004 1-9
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To manually synchronize the databases:

1. In the left pane, choose Locations.

2. From the Setup menu, select Synchronize Directory Services.

When the synchronization is complete, the system displays a confirmation 
message.
1-10 October 29, 2004
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Enterprise Data 
Configuration
Introduction

Enterprise Data Configuration enables you to:

■ Set up fields and layouts displayed by the Enterprise Data application

■ Set the CallManager CTI server used by the system

■ Configure the VoIP Monitor server(s) to monitor specific devices

■ Set a default VoIP Monitor server

To use Enterprise Data Configuration, select either the Enterprise Data node or 
the VoIP Monitor node in the left navigation pane of the Desktop Administrator 
window. 
2-1
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Toolbar and Menu Bar

Toolbar

The Enterprise Data Configuration toolbar contains four buttons.

Move your cursor over a button to view a tooltip describing its function.

Menu Bar

Enterprise Data Configuration includes the following menu bar options:

Button Name Description

Enterprise 
Configuration

Configures the CallManager CTI server 
(Enterprise Data subnode only)

Web Opens your web browser and access Cisco’s 
website

Help Accesses online help

About Displays copyright and version information

Option Description

Edit Configures the CallManager CTI server 
(Enterprise Data subnode only)

Window Toggles your control from one pane to the other

Help Accesses online help and displays copyright 
and version information
2-2 October 29, 2004



Enterprise Data
Enterprise Data

The Enterprise Data node enables you to set up fields and layouts displayed by 
the Enterprise Data application.

To use Enterprise Data, select the Enterprise Data node in the left navigation 
pane of the Desktop Administrator window. The Enterprise Data Configuration 
window appears, as shown in Figure 2-1.

Figure 2-1. The Enterprise Data Configuration window.
October 29, 2004 2-3
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Configuring Cisco Enterprise Data

When Cisco Enterprise Data is enabled on an agent desktop (see “Enterprise 
Data” on page 3-50), enterprise data associated with an incoming call is 
displayed on the agent desktop, as shown in Figure 2-2. 

Figure 2-2. Enterprise Data as displayed on the agent desktop.

You can use the Enterprise Data Configuration window to specify what 
information is displayed in the left pane of the Enterprise Data window and how it 
appears. When you select Enterprise Data Configuration in the Navigation pane, 
the Display pane displays the Field List and Layout List.

NOTE:  Agents must restart Agent Desktop to view any changes you have 
made to enterprise data fields and layouts. 

Fields

The Field List displays both predefined fields available for your switch type and 
custom fields you create using the Field Editor. 

Predefined fields have index numbers of 231–255 and may not be edited. 
Custom fields may use index numbers 0–230 and may be edited. 

To add a custom field to the Field List:

1. In the Field List area, click Add.

The Field List Editor dialog box appears. (See Figure 2-3.)
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Enterprise Data
Figure 2-3. The Field Editor dialog box.

2. Choose a field index number from the drop-down list. 

The field automatically shows the next available number.

3. Enter a field name that describes the contents of the field. 

The field name can contain:

■ alphanumeric characters (Aa–Zz, 0–9)

■ underscore ( _ )

■ period ( . )

The field name cannot contain the following characters (if used, the 
enterprise data field will not pop in the IP Phone Agent service):

■ left and right angle brackets ( < > )

■ ampersand ( & )

■ apostrophe ( ‘ )

■ double quotes ( “ )

■ space

4. Click OK.

The Field Editor dialog box closes.

5. In the Enterprise Data Configuration window, click Apply to save your 
changes.

To edit an existing custom field:

1. In the field list, select the field you want to edit, and then click Edit.

The Field Editor dialog box appears.

2. Enter your change, and then click OK.

The Field Editor dialog box closes.

NOTE: You can edit the custom field’s name only, not its number.
October 29, 2004 2-5
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3. In the Enterprise Data Configuration window, click Apply to save your 
changes.

To delete a custom field:

1. N the field list, select the field you want to delete. 

NOTE: You can delete custom fields only.

2. Click Delete.

3. Click Apply to save your changes.

Layouts

The Layout List displays the field layouts available for use on the agent desktop. 
Each layout may contain up to 16 fields chosen from the fields in the Field List.

During a screen pop, the data layout used (if other than the default) is determined 
by an ICD application script.

To use a layout other than the default layout:

1. Create a new layout. (See the procedure that follows.)

A field with an index of 252 already exists and is associated with the field 
name “Layout.” This is the index (datatype) for all layouts.

2. Write an ICD Application script that contains the Set Enterprise Server 
Data Step(s), and reference the new layout name in the script.

The Enterprise datatype field in the Set Enterprise Server Data step should 
be 252, and the Enterprise datavalue should be the name of the layout you 
created in Step 1. 

The datatype is 252 for all layouts. Only the layout name differs. If a 
specific layout name is not referenced, the default layout will be used to 
display enterprise data. 

See the ICD Steps and Developers Guide for information on creating ICD 
Applications scripts and the Enterprise Steps.

To create a new layout:

1. In the Layout List area, click Add.

The Layout Editor dialog box appears. (See Figure 2-4.)
2-6 October 29, 2004
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Figure 2-4. The Layout Editor dialog box.

2. In the Layout Name field, enter a name for your layout.

3. Select the desired field from the available fields in the right pane and either 
click the left arrow button or double-click your selection to move it to the 
left pane. You may select up to 16 fields.

4. To rearrange the order in which fields are displayed in the left pane, select 
a field and click the up or down arrow button to move the field up or down 
in the list.

5. When the layout is arranged to your satisfaction, click OK.

The Layout Editor dialog box closes. 

6. In the Enterprise Data Configuration window, click Apply to save your 
changes.

To edit an existing layout:

1. In the Layout List, select the layout you want to edit, and then click Edit.

The Layout Editor dialog box appears. (See Figure 2-4.)

2. Make your changes.

3. Click OK.

The Layout Editor dialog box closes.

4. In the Enterprise Data Configuration window, click Apply to save your 
changes.

To delete an existing layout:

1. In the Layout List, select the layout you want to delete.
October 29, 2004 2-7
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2. Click Delete.

The layout is deleted.

3. In the Enterprise Data Configuration window, click Apply to save your 
changes.

Enterprise Configuration

Use the Enterprise Configuration dialog box to configure the CallManager CTI 
server. 

To access the Enterprise Configuration dialog box, you can either:

■ Click the Configuration button on the toolbar.

■ From the Edit menu, choose Configuration.

Figure 2-5. Enterprise Configuration dialog box.

The CallManager CTI Server tab (see Figure 2-5) displays the host name or IP 
address and port number for the CallManager CTI server.

To change CallManager CTI server information:

1. On the CallManager CTI Server tab, enter your changes in the appropriate 
field.

2. Click Apply to save your changes.
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VoIP Monitor

The VoIP Monitor window (Figure 2-6) enables you to set a default VoIP Monitor 
server and to configure devices to be monitored by specific VoIP Monitor servers.

Figure 2-6. The VoIP Monitor window.

If your system has only one VoIP Monitor server, it is not necessary to set a 
default monitor server or to manually assign each device to that single monitor. 
The VoIP Monitor server assumes that each device is assigned to it as the only 
available monitor server.

It is advisable to select a default monitor server to avoid the possibility of having 
devices unassigned to any monitor server. This situation can arise when there is 
more than one VoIP Monitor server in the system.

Modifications you make in the VoIP Monitor window go into effect immediately.

Devices Displayed in the VoIP Monitor Window
The following devices are displayed in the VoIP Monitor window:

■ All agent phones set up as ICD devices in the CallManager. 
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■ All phones that have been assigned to the RM JTAPI user, but have not 
been assigned to an agent. The RM JTAPI user is the user that the 
Resource Manager subsystem uses to authenticate to the CallManager. 
For more information, see your Cisco CallManager user documentation. 

If a phone is configured for extension mobility, the Extension field displays the 
static extension assigned to the device’s MAC address, if a static extension is set 
up. If no static extension is set up, the Extension field is blank.

NOTE:  We recommend you assign a static extension to an extension 
mobility device to make administration easier.

To set a default VoIP Monitor server:

■ From the Default VoIP Monitor Server field, choose a monitor server. 

The monitor server you choose is set as the default monitor server for your 
system. Any device not assigned to a specific VoIP Monitor server is 
monitored by the default monitor server.

To assign a device to a specific VoIP Monitor server:

1. Using either the device’s extension or the MAC address, locate the device 
you wish to assign to a specific VoIP Monitor server. 

You can click on a column header to sort the column in ascending or 
descending order to make your search easier.

2. Choose a VoIP monitor from the Monitor Server dropdown list. 

You can right-click anywhere in a device’s row to pop up the Select a 
VoIP Monitor Server dialog box from which to choose a VoIP Monitor 
server.

The device is now assigned to that VoIP Monitor server.

To assign multiple devices to a specific VoIP Monitor server:

1. Use standard Windows multiple selection techniques to assign more than 
one device to a specific VoIP Monitor server:

■ Shift-Click to select a range of contiguous devices, then right-click 
the selected devices to display the Select a VoIP Monitor Server 
dialog box.

■ Ctrl-Click to select non-contiguous devices, then right-click the 
selected devices to display the Select a VoIP Monitor Server 
dialog box.

2. Choose the VoIP Monitor server from the dropdown list, and then click OK.

The devices you selected are now assigned to that VoIP Monitor server.
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Removing a VoIP Monitor Server from Directory 
Services

The Remove button in the VoIP Monitor window enables you to remove a VoIP 
Monitor server from Directory Services.

Remove a VoIP Monitor server only if you intend to uninstall (or already have 
uninstalled) the VoIP Monitor server permanently. The Remove function enables 
you to clean up Directory Services.

NOTE:  Removing a VoIP Monitor server can result in devices becoming 
unmonitored. See Table 2-1 for possible outcomes.

Table 2-1. Consequences of Removing a VoIP Monitor Server from Directory Services

Starting no.
of monitors
in system Description Status of devices assigned to removed server

1 Server A
(may or may not be set 
as default)

Remove A: All devices are now unmonitored

2 Server A (default)
Server B

Remove A: All devices assigned to A are now 
monitored by B because B is only monitor 
left

Remove B: All devices assigned to B are now 
monitored by A, because A is set as 
default (and is the only monitor left)

3 or more Server A (default)
Server B
Server C

Remove A: All devices assigned to A are now 
unmonitored because there is no default 
set; also, all devices that were unassigned 
to a specific monitor and were monitored 
by the default monitor are now 
unmonitored

Remove B: All devices assigned to B are now 
monitored by default monitor A

Remove C: All devices assigned to C are now 
monitored by default monitor A
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To remove a VoIP Monitor Server from Directory Services:

1. Click the Remove button in the VoIP Monitor window.

The Select a VoIP Monitor Server dialog box appears.

2. Choose a VoIP Monitor server from the dropdown list, and then click OK.

The selected server is removed from Directory Services.

To restore a removed VoIP Monitor Server back into Directory Services:

1. Stop and then restart the removed VoIP Monitor server from the Windows 
Services dialog box.

2. Stop and then restart Desktop Administrator.

The VoIP Monitor server is restored to the list of available monitor servers.
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Desktop Configuration
Introduction

Desktop Configuration enables you to configure and maintain the appearance 
and behavior of Agent Desktop. Desktop Configuration has four functions:

■ Dial Strings

■ Phone Book

■ Reason Codes

■ Work Flow Groups

To use any Desktop Configuration application, select its node in the left 
Navigation pane of the Desktop Administrator window. (See Figure 3-1.) The right 
Display pane shows the selected application.

NOTE:  Desktop Configuration functions can be password protected. See 
“Passwords” on page 7. for more information.

NOTE:  The User Interface and Work Flow functions under Work Flow 
Groups are disabled in Standard Desktop Administrator. These features 
are available only in Enhanced Desktop Administrator.
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Figure 3-1. The Desktop Configuration window.
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Toolbar and Menu Bar

Toolbar

The Desktop Configuration toolbar contains six buttons.

Move your cursor over a button to view a tooltip describing its function.

Menu Bar

Desktop Configuration has the following menu options:

Button Name Description

New Adds a new work flow group (enabled when a 
Work Flow Group subnode is selected)

Delete Deletes the selected work flow group

Properties Displays the configuration file path of the selected 
work flow group

Web Opens your web browser and accesses Cisco’s 
website

Help Accesses online help

About Displays copyright and version information

Option Description

File

New Adds a new work flow group

Delete Deletes a work flow group

Rename Renames a work flow group

Properties Displays a work flow group’s configuration file 
path
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Copy Macros Copies one work flow group’s macros to another 
work flow group

Change Password Enables you to change your password or create a 
new one

View Hides/shows the Desktop Configuration toolbar

Monitoring

Notify Monitoring Select to notify agents that the supervisor is 
monitoring phone conversations

Notify Recording Select to notify agents that the supervisor is 
recording phone conversations

Window Toggles your control from one pane to the other

Help Accesses online help and copyright and version 
information

Option Description
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Dial Strings

Use the Dial Strings function to configure the way Agent Desktop displays and 
dials phone numbers.

Check the appropriate check box at the bottom of the Dial Strings pane to 
choose the dial string format you will use. The available formats are: 

■ North American Dial String format

■ Variable Format Dial String format

Different tabs display depending on your choice.

North American Dial String Format

If you choose the North American dial string format, the following three tabs are 
active:

Telephone Number Display Tab

The Telephone Number Display tab (Figure 3-2) enables you to configure how 
phone numbers are displayed in Agent Desktop. 

The selections you make are reflected in the Sample fields. (An exception is if you 
enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” 
fields. In that case, the sample does not change.)

Figure 3-2. Telephone Number Display tab.
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To configure the telephone number display:

■ Check or uncheck the check boxes and radio buttons on the Telephone 
Number Display tab as desired, and then click Apply to save your 
changes.

Outgoing Calls Tab

The Outgoing Calls tab (Figure 3-3) enables you to configure your local area 
codes and exchanges.

Figure 3-3. Outgoing Calls tab.

Tab Section Description

External number format Specify the ANI and DNIS phone numbers format

Area code/Exchange Specify the separator between the area code and 
exchange

Exchange/Subscriber 
code

Specify the separator between the exchange and the 
subscriber code

Internal number format Specify the internal phone numbers format. You may 
include an X (extension) and remove the leading or 
trailing digits (in the event that extension numbers are 
less than 4 digits long). 
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To configure outgoing calls:

■ Enter information and check or uncheck the appropriate check boxes on 
the Outgoing Calls tab as desired, and then click Apply to save your 
changes.

Tab Section Description

Local area code Enter the local 3-digit area code.

Advanced Dialing… Click to configure advanced internal and external 
dialing. (See page 3-8.)

Prefixes • Local line access code. Enter the number 
required to access an outside local line

• Long distance line access code. The number 
required to access an outside long distance line

• Ensure a 1 on long distance calls. Check to 
automatically add a 1 at the beginning of a long 
distance phone number

• Use area code for toll calls within the area code. 
Check to automatically add the local area code to 
any calls dialed to numbers not included in the 
local exchange list.

• Use area code for local calls. Check to 
automatically add the local area code to any calls 
dialed to numbers included in the local exchange 
list.

Local exchanges Check All exchanges are local or click Add to build 
a list of exchanges for which it is NOT necessary to 
add a 1 before dialing
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Advanced Internal Dialing

The Advanced Internal Dialing tab (Figure 3-4) enables you to configure more 
internal dialing options. Access it by clicking the Advanced Dialing button on the 
Outgoing Calls tab.

Figure 3-4. Advanced Internal Dialing tab.

Tab Section Description

Extensions The maximum number of digits in an internal 
extension number, from 1–7. If you select 7, you must 
specify the internal exchange and the corresponding 
range of subscriber numbers so the application can 
distinguish between a 7-digit internal phone number 
and a 7-digit outgoing call.

7-digit extensions If you specified a 7-digit extension number, enter the 
internal exchange and the corresponding range of 
extension numbers from low to high. Click Add to 
add them to the list.
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Advanced External Dialing Tab

The Advanced External Dialing tab (Figure 3-5) enables you to configure more 
external dialing options. Access it by clicking the Advanced Dialing button on the 
Outgoing Calls tab.

Figure 3-5. Advanced External Dialing tab.

Window Section Description

Neighboring area codes 
with local dialing 
privileges

The area codes to which you can place non-toll calls. 
Click Add to add a new area code to the list and click 
Delete to remove an area code from the list.

Exchanges for 7-digit 
local numbers

Choose the neighboring area code, then enter the 
exchanges within that area code which do not require 
you to dial 1 or the area code. Check All exchanges 
as 7-digit numbers if no exchange requires you to 
dial 1 or an area code.

Exchanges for 10-digit 
local numbers

Choose the neighboring area code, then enter the 
exchanges within that area code that require you to 
dial the area code but not a 1. Check All exchanges 
as 10-digit numbers if all exchanges require you to 
dial an area code but not a 1.
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Miscellaneous Tab

The Miscellaneous tab (Figure 3-6) sets up further dialing properties. 

NOTE:  This tab is the same for the North American and variable length dial 
string formats.

Figure 3-6. Miscellaneous tab

Tab Section Description

Use text from the 
clipboard as the phone 
number when pressing 
the call button

Check to enable Agent Desktop to use text on the 
clipboard as the dialed number when the Call button 
is pressed, as long as the text on the clipboard is a 
valid text string.

Show the dial pad when 
using text from the 
clipboard for dialing.

Available only if “Use text from the clipboard…” is 
enabled. Check to display the dial pad before dialing 
a number copied from the clipboard. If this box is not 
checked, Agent Desktop dials the number without 
displaying the dial pad.

Convert text to digits in 
phone numbers

Converts phone numbers expressed in alpha 
characters (for example, 1-800-ANYWORD) to their 
numeric equivalents before dialing.
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To configure the miscellaneous options:

■ Check or uncheck the appropriate check boxes on the Miscellaneous tab 
as desired, and then click Apply to save your changes.

Variable Length Dial String Format

If you choose the variable length dial string format, the following three tabs are 
active:

Telephone Number Display Tab

The Telephone Number Display tab (Figure 3-7) enables you to configure how 
phone numbers are displayed in Agent Desktop. 

The selections you make are reflected in the Sample fields. (An exception is if you 
enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” 
fields. In that case, the sample does not change.)

NOTE:  The number of digits displayed in each section of the sample 
phone number is for illustration only. The samples do not reflect the 
number format you set up on the Phone Number Format tab.

Figure 3-7. Telephone Number Display tab.
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To configure the telephone number display:

■ Enter data and check or uncheck the appropriate check boxes and radio 
buttons on the Telephone Number Display tab as desired, and then click 
Apply to save your changes.

Phone Number Format Tab

The Phone Number Format tab (Figure 3-8) enables you to establish the format 
for phone numbers that do not follow the North American dial string format. You 
can also set the maximum number of digits in an internal phone extension.

You can establish as many formats as you want, as long as each one has a 
unique total length. 

Tab Section Description

External number format Specify how you want to view ANI and DNIS phone 
numbers.

City/subscriber code Specify the separator you want to display between 
the city code and the subscriber code.

Internal number format Specify how internal phone numbers are displayed. 
You may include an X (extension) and remove the 
leading or trailing digits (in the event that extension 
numbers are less than 4 digits long).
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Figure 3-8. Phone Number Format tab.

To add a new phone number format:

1. Click Add. 

The Add City/Subscriber Code Lengths dialog box appears.

2. Enter the number of digits in the city code and the subscriber code, and 
then click OK. 

The numbers you entered are displayed in the phone number format pane, 
along with the calculated total length of the format. You cannot enter 
another format with the same total length.

3. Click Apply.

The new phone number format is saved.

To edit a phone number format:

1. Choose the number format, and then click Edit.

The Edit City/Subscriber Code Lengths dialog box appears.

2. Make your changes, and then click OK.

3. Click Apply to save your changes.

The phone number format is changed.
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To delete a phone number format:

1. Choose the number format, and then click Delete.

2. Click Apply to save your changes.

The phone number format is deleted.

Miscellaneous Tab

The Miscellaneous tab for the variable length dial string format is the same as the 
tab for the North American dial string format. 

See “Miscellaneous Tab” on page 3-10 for an description of the Miscellaneous 
Tab.
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Phone Book

Agents have several lists of phone numbers available to them:

■ The Recent Call List, a dynamic list of up to 100 recently called phone 
numbers kept by Agent Desktop

■ A personal phone book, created and maintained by the agent (and 
enabled/disabled by the system administrator)

■ Global phone books, created by the system administrator with the Phone 
Book function

The Phone Book window (Figure 3-9) enables you to set up and manage the 
global phone books that are shared by agents. Phone books and phone book 
entries are created and maintained in the Phone Book Editor dialog box (Figure 
3-10).

Figure 3-9. Phone Book window.
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The Phone Book Editor enables you to set up and maintain global phone books.

To set up a new phone book:

1. In the Phone Book window, click Edit.

The Phone Book Editor dialog box appears.

Figure 3-10. Phone Book Editor dialog box.

Window Section Description

Disable all phone books Check to prevent agents from viewing global or 
personal phone books.

Disable personal phone 
book

Check to disable agents’ personal phone books.

Phone Books Select the phone book you want to view or edit from 
the drop-down list.

Edit Click to create and edit phone books using the 
Phone Book Editor.
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2. Enter a new phone book name in the Phone Books field, and then click 
Add.

The name of the new phone book is added to the list of phone books.

3. Click OK.

The new phone book is saved and the Phone Book Editor dialog box 
closes.

To add phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from 
the drop-down list, and then click Edit.

The Phone Book Editor dialog box appears.

2. Enter a name, phone number, and note (optional) for a person or company, 
and then click Add to add the information to the phone book.

3. Repeat Step 2 as needed to enter all entries to the phone book. When all 
entries are completed, click OK.

Your entries are saved and the Phone Book Editor dialog box closes.

To edit phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from 
the drop-down list, and then click Edit.

The Phone Book Editor dialog box appears.

2. Choose an entry in the phone book, and then take one of these actions:

■ Click Edit, and then change the entry

■ Click Delete to delete the entry

3. When all edits are completed, click OK.

Your changes are saved and the Phone Book Editor dialog box closes.
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Reason Codes

Reason codes describe why an agent has changed to the Not Ready agent state 
or has logged out. Reason codes are set up and maintained using the Reason 
Code window (Figure 3-11).

Figure 3-11. Reason Code window.

Reserved reason codes (identified by [RESERVED] after the description) are 
predefined in Directory Services and cannot be created or deleted. You can, 
however, change a reserved reason code’s number. 

NOTE:  You cannot enable reason codes unless at least one user-defined 
reason code exists for Logout and one exists for Not Ready. 

NOTE:  IP phone sets do not support double-byte character sets. Any 
reason codes entered as double-byte characters will display as question 
marks.

When creating reason codes, follow these guidelines:

■ Descriptions may consist of up to 40 alphanumeric characters. No 
punctuation or other characters are allowed.

■ No agent state may contain duplicate numbers and descriptions among its 
reason codes.
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■ Reason code numbers must be between 1 and 999.

■ Reason codes are either all enabled or all disabled for all agent states. You 
cannot enable reason codes for one state and disable them for another.

To enable reason codes:

■ Check the Enable reason codes check box, and then click Apply.

If at least one user defined reason code exists for Not Ready and one 
exists for Logout, reason codes are now enabled. 

To add a new reason code:

1. Choose the Logout or Not Ready tab, depending on the type of reason 
code you wish to create.

1. Enter a unique number and description for the reason code, and then click 
Add.

The new reason code is added to the reason code list.

2. Click Apply to save your changes.

To edit an existing reason code:

1. Choose the reason code you want to edit from the list. 

The reason code appears in the edit field.

2. Make your changes, and then click Edit.

The edited reason code appears in the reason code list.

3. Click Apply to save your changes.

To delete an existing reason code:

1. Select the reason code you want to delete.

The reason code appears in the edit field.

2. Click Delete.

The reason code is deleted from the reason code list.

3. Click Apply to save your changes.

To cancel your changes before saving them:

1. Do not click Apply after you have made a change. 

2. Click on another node in the Navigation pane to leave the Reason Code 
window.
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Work Flow Groups

Use the Work Flow Groups function to create and configure agent work flows 
and to customize the Agent Desktop interface. 

Figure 3-12. The Work Flow Groups window.

Under the Work Flow Groups node are subnodes describing agent types. 

NOTE:  Agent types are predetermined and may differ depending on the 
switch used.

Underneath each agent type are the specific work flow groups for that agent 
type. When you click on a specific work flow group in the left pane, the right pane 
displays three buttons:

■ User Interface. This button enables you to configure the Agent Desktop 
interface for the selected work flow group (not available in Standard 
Desktop Administrator).

■ Work Flow. This button enables you to create and edit work flows for the 
selected work flow group (not available in Standard Desktop 
Administrator).

■ Enterprise Data. This button enables you to configure enterprise data on 
the agent desktop for the selected work flow group.
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Maintaining Work Flow Groups

You can add, delete, or edit work flow groups. 

To add a new work flow group:

1. In the Navigation pane, choose an agent type or work flow group subnode 
(for example, under Agents, choose the Default work flow group).

2. From the File menu, choose New.

The Work Flow Group Name Editor dialog box appears.

3. Enter a new work flow group name. 

If you want to copy an existing work flow group, check the “Copy the 
following work flow group check” box and choose a work flow group from 
the drop-down list.

4. Click OK.

The new work flow group appears in the Navigation pane.

To edit an existing work flow group:

1. In the Navigation pane, choose the work flow group you want to edit.

2. From the File menu, choose:

■ Rename to rename the group.

Type over the work flow group’s name in the navigation tree, and 
then press Enter.

■ Delete to delete the group. (See the procedure on page 3-22.)

■ Properties to view a dialog box showing the group’s configuration 
file path.

Click OK to close the dialog box.

■ Copy Macros to copy the macros of the selected work flow group 
to another work flow group.

The Copy Macros dialog box appears. Select the destination work 
flow group from the drop-down list. You are warned that macros 
with identical names will be overwritten. Click OK to continue 
copying the macros.
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To delete an existing work flow group:

1. In the Navigation pane, choose the work flow group you want to delete.

2. From the File menu, choose Delete to delete the group.

You are warned that all agents belonging to the work flow group you want 
to delete must be reassigned to other work flow groups. 

3. Click Yes to confirm the deletion, or No to cancel it.

NOTE:  If you do delete a work flow group before reassigning the agents 
who belong to it, you will not be able to reassign those agents. To resolve 
this problem, first recreate the work flow group by adding a new work flow 
group with the same name as the deleted group. You will then be able to 
reassign the affected agents. Once you have reassigned the agents, you 
may once again delete the work flow group.
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User Interface Setup

The User Interface Setup window enables you to configure the appearance and 
behavior of Agent Desktop.

NOTE:  This functionality is not available in Standard Desktop 
Administrator. 

Toolbar Tab

The Toolbar tab (Figure 3-13) enables you to:

■ Show or hide buttons on the Agent Desktop toolbar

■ Associate actions with task buttons

■ Change task button hints

■ Change the size of the toolbar buttons and the size of the icons displayed 
on the buttons

■ Customize icons

Figure 3-13. Toolbar tab.
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Buttons and Icons

Buttons are the gray squares visible on the Agent Desktop toolbar. Icons are the 
pictures on the buttons. You can control the size of the button as well as the size 
of the icon. You can also choose to use different icons on the buttons to 
customize the toolbar.

Large buttons and icons are 32 × 32 pixels. Small buttons and icons are 16 × 16 
pixels. The default setting is small buttons and icons.

See Figure 3-14 for a comparison of the two button sizes. In this example, the 
button sizes are different, but the icon sizes are the same. 

Figure 3-14. Comparison of Agent Desktop with large buttons (top) and small buttons 
(bottom) and small icons (both).

You can choose to display large icons on the buttons. See the procedure for 
customizing icons on page 3-25.

NOTE:  If you use large icons without choosing to display large buttons, 
the icons will be compressed to fit on the small buttons, and may appear 
distorted or blurry.

To display large buttons:

■ Check the Display Large Toolbar Buttons check box.

NOTE: Agents must restart Agent Desktop for this change to take effect.
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To customize an icon:

1. Choose the button whose icon you want to customize.

2. Click Customize Icon.

The Choose Icon dialog box appears (Figure 3-15), displaying the default 
set of small icons. Check the View Large Icons in this Directory check 
box if you want to use a large icon.

Figure 3-15. Choose Icon dialog box.

You can also click Browse to navigate to a directory containing icons if you 
wish to use your own icon set. This directory must be on a networked drive 
so it is accessible by all agent PCs. If it is not, the icon change will not 
show up on the agent desktop.

3. Choose an icon. 

The icon is displayed in the Preview area.

4. Click OK. 

The button is displayed with the new icon on it in the button list.
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To add a button to the toolbar:

■ Choose a button in the list of available buttons and check the Visible 
check box.

To associate an action with a task button:
You can associate as many actions with a task button as you wish. The actions 
are executed sequentially in the order they are listed in the Action window.

NOTE:  Bear in mind the amount of time it takes to execute actions. 
Generally, a maximum of two or three actions per task button is 
recommended.

1. Choose a task button in the list of available buttons. 

The default task buttons are the buttons numbered 1–10, which can be 
customized if you desire.

2. Check the Visible check box.

The Actions pane and its associated buttons become enabled.

3. Under the Actions pane, Click Add.

The Select Action window appears. 

4. Click the appropriate tab to select the action you want to associate with 
the button.

You can select an existing action or set up a new action. (See “Actions” on 
page 35. for more information on setting up new actions.)

5. Click OK.

The Toolbar tab is displayed.

6. Type a short description of the action in the Hint field.

NOTE: You cannot change the shortcut key combination.

7. Repeat Steps 3–6 if you want to add other actions to the same task 
button. 

To change a task button’s hint:

1. Choose the button whose hint you want to change.

2. In the Hint field, type your change. 

NOTE: You cannot change the shortcut key combination.

3. Click OK.
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Show Data Fields Tab

The Show Data Fields tab (Figure 3-16) configures the data fields that appear in 
the Call Information pane in Agent Desktop.

The left pane displays the fields that appear in Agent Desktop. The right pane 
displays the fields available. Use the left and right arrows to move the available 
fields between the two panes, and the up and down arrows to set the left-to-right 
order in which they appear in Agent Desktop.

NOTE:  The left pane must contain at least one field.

To rename a data field:

1. Double-click the field.

The Rename dialog box appears. 

Enter a new name, and then click OK.

Figure 3-16. Show Data Fields tab.
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Miscellaneous Tab

Use the Miscellaneous tab (Figure 3-17) to set other user interface options.

Figure 3-17. Miscellaneous tab.
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Option Description

Agent Window Behavior Specify how you want the Agent Desktop window to 
behave:

Normal. The window appears when calls are present 
and minimizes when idle.

Keep Open. The window is always visible, but may 
be hidden by other open applications.

Always on Top. The window is always visible and on 
top of other open applications.

Stealth. The window appears as an icon in the 
system tray.

Macro Hot Key Specify the key you want to use to pause macro 
recording and display the Suspend Macro Recording 
dialog. The default is F2.

Allow Local 
Administration

Check to allow agents to make temporary changes to 
their user interfaces. Note that permanent changes 
must be made through Desktop Administrator.

Rules and Actions only 
apply to the first call 
appearance

Check to invoke rules processing only for the oldest 
(top) call appearance. If the box is not checked, rules 
processing is invoked for all calls.

Show Status Bar Check to display the status bar.
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Work Flow

NOTE:  This functionality is not available in Standard Desktop 
Administrator.

A work flow is a sequence of actions that takes place when a specific call event 
occurs. Use the Work Flow Setup window (Figure 3-18) to set up a work flow. 

To set up a work flow, you must configure the following three functions:

■ Event. An occurrence. Available events are startup, shutdown, ringing, 
answered, and dropped.

■ Rule. A data condition that must be met before an action is performed.

■ Action. An occurrence that happens when a rule is met.

When an event occurs, rules are evaluated. If a rule is met, an action takes place. 
For instance, a work flow could be set up so that an incoming call from a specific 
phone number is transferred to a specific agent:

■ The event is Ringing;

■ The rule is that the incoming phone number is 612-555-3271;

■ The action is a blind transfer to agent Mary Jones.

The general procedure for setting up a work flow is:

1. Select the event that triggers the work flow.

2. Set up one or more rules to determine if the action(s) should be run, and 
determine whether the action runs if either any of the rule’s data conditions 
are met, or if all the rule’s data conditions are met. 

3. Choose one or more actions to run when the event occurs and the rules 
are met. Actions run in the order in which they appear in the list.

Notes on Setting Up Work Flows
When an application or call event occurs, the rules are evaluated in order. When 
a rule is met, all actions assigned to the rule run in order and subsequent rules are 
not evaluated.

Each event has a default rule that runs if all other rules are not met. The default 
rule cannot be deleted, and is always last in the list of rules applying to an event.
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Figure 3-18. Work Flow Setup window.

Window Section Description

Events Select the occurrence to associate with rules and 
actions.

Rules 
(of current Event)

Specify the rules to associate with the selected 
event.

Actions 
(of current Rule)

Specify the actions to associate with the selected 
rule.

Current Rule Conditions Enable Rule. Check to put the rule into effect.

Execute Actions When. Check either Any Condition 
is True or All Conditions are True. This sets the data 
conditions for the rule to “Or” or “And” statements.

Data Field Conditions. Specify up to 3 data field 
conditions set up for the rule. Click the Edit button 
next to each condition to create or edit it. 
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Events

Events are application and call occurrences in Agent Desktop. Available events 
are:

Rules

A rule is a set of one to three data field conditions. Each data field condition is set 
up separately. 

When an event occurs, the rules associated with the event are executed in the 
order they are listed in the Work Flow Setup window (Figure 3-18).

When a rule is met, the actions associated with that rule are executed in the order 
they are listed in the Work Flow Setup window. Subsequent rules are not 
evaluated.

If no rules are met, the default rule governs, and all actions associated with the 
default rule are executed. 

NOTE:  The default action might be <no action>. Default rules cannot be 
changed or deleted.

You can specify that an action is to be run if any data condition is true or if all data 
conditions are true by selecting the appropriate check box in the Work Flow 
Setup window.

Event Description

Startup Agent Desktop starts on the agent’s computer. No rules can 
be assigned to this event.

Shutdown Agent Desktop shuts down on the agent’s computer. No 
rules can be assigned to this event.

Ringing The agent’s phone rings.

Answered The agent answers an incoming phone call.

Dropped The phone call is terminated.
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Setting Up a New Rule

To set up a new rule:

1. From the Work Flow Setup window, under the Rules area, click New.

The New Rule Name dialog box appears (Figure 3-19).

2. Enter an appropriate name for the new rule, and then click OK. 

The new rule is now listed in the Rules pane in the Work Flow Setup 
window. You many now set up one to three data field conditions to apply 
to the new rule.

Figure 3-19. New Rule Name dialog box.

3. With the new rule selected, click Edit next to the first Data Field 
Conditions field.

The Data Field Conditions dialog box appears. 

Figure 3-20. Data Field Conditions dialog box
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4. Select a data field from the Data Field drop-down list.

5. Specify one of the data field filters:

6. Check Enable Condition, and then click OK. 

The rule is now set up. You must associate it with an action and enable it in 
the Work Flow Setup window to put it into effect.

Filter Description

Is Empty Data field is empty.

Is Not Empty Data field is not empty.

Is in the List Data field is included in the list you set up in 
the List pane. Click Add to add an item to the 
list of strings. 

Note: Items in the list may not include 
commas.

For more information on adding strings, see 
“Wild Card Searches” on page 3-35.

In Not in the List Data field is not included in the list you set up 
in the List pane. Click Add to add an item to 
the list of strings.

Note: Items in the list may not include 
commas.

For more information on adding strings, see 
“Wild Card Searches” on page 3-35.

Length of Data Data field is within a specified range set in the 
Length of Data fields. Typical use is to 
differentiate between internal and external 
calls. Internal calls are 4-digit numbers, and 
external calls are 8- to 12-digit numbers. 

Enter the minimum and maximum length of 
data fields. 

Note: if your dial plan is set up to preface 
internal numbers with an “x”, the data 
condition must also include an “x”.
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Wild Card Searches
You can use wild cards when entering items in the list pane in the Data Field 
Conditions dialog box (Figure 3-20). This enables you to avoid having to enter 
whole strings if the items you wish to list have common string elements. 

Wild card characters used are the asterisk ( * ) and the question mark ( ? ). 

Asterisk wild card.   An asterisk in a string may be replaced by any quantity of 
any character, as long as the other characters in the string match. For instance:

■ ABC* matches ABCD, ABCDEERRGFG, and ABC$@, among others. All 
these matches start with ABC.

■ *ABC matches DDABC, @#ABC, and 1234ABC, among others. All 
theses matches end with ABC.

Question mark wild card.   A question mark in a string may be replaced by any 
character, but the length of the string must be exactly as represented. For 
instance:

■ ABC? matches ABCD, ABC1, and ABC$, among others. The character 
represented by the question mark doesn’t matter, but the length of the 
string must be four characters.

■ ??ABC matches 12ABC, $%ABC, and FEABC, among others. The two 
characters at the beginning of the string may be replaced by any character, 
but the length of the string must remain five characters.

Actions

Actions include:

Action Description

Run Macro Play back a recorded sequence of keystrokes. (See page 
3-37.)

Call Control Answer, drop, call, conference, or transfer a call, or input 
touch tones during a call. (See page 3-44.)

Launch External 
Application

Start a third-party application. (See page 3-45.)

Agent State Set an agent state. (See page 3-47.)

Utility Action Run a utility, such as start and stop recording or sending a 
predefined, high-priority chat message to a supervisor. (See 
page 3-48.)
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Actions are stored independently of events and rules.You can use an action in 
more than one event, and you can assign actions to more than one task button in 
Agent Desktop.

For instance, if a rule is true, the actions associated with it may launch an 
application and then play a macro to that application. While actions are being 
processed, events are queued. It is generally a good idea to avoid long actions.

To add a new action:

1. In the Work Flow Setup window (Figure 3-18), select the event to be 
associated with the new action.

2. Under the Actions area, click Add.

The Select Action dialog box appears. (See Figure 3-21.)

Figure 3-21. The Select Action dialog box (Utility Action tab selected).

3. Choose the tab for the type of action you want to associate with the event. 

4. If the action already exists, select it, and then click OK.

If the action does not yet exist, click New and follow the instructions for 
setting up that type of action as outlined below.

5. Click OK.

The Select Action dialog box closes and you return to the Work Flow 
Setup window. The new action is listed in the Actions pane.
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To edit an action:

1. In the Work Flow Setup window, select the appropriate event, and then 
select the action you want to edit from the Actions pane. 

2. Click Edit.

One of several edit action dialog boxes appears (depending on the action 
you have chosen to edit).

3. Make your changes, and then click OK.

The action is now changed.

To permanently delete an action:

To permanently delete an action, you must first delete it from any event it is 
associated with, and then delete the action itself. 

1. In the Work Flow Setup window, select each event. If the action you want 
to delete is associated with that event, select the action in the Action pane 
and click Delete to remove it from that event.

The action is now removed from all events.

2. Under the Actions pane, click Add.

The Select Actions dialog box appears.

3. Choose the appropriate tab, and then select the action you want to delete.

4. Click Delete.

The action is deleted.

5. Click OK.

The Select Action dialog box closes and you return to the Work Flow 
Setup window. 

Run Macro Action

A macro is a shortcut for a sequence of keystrokes. For example, you might 
record a macro that performs the following tasks with each incoming call:

■ Copy the ANI (Automatic Number Identification) from Agent Desktop to 
Microsoft Outlook

■ Open a contact list

■ Find the ANI in a database or spreadsheet

■ Display a screen containing the caller’s account information

For examples of creating macros, see Chapter 6, “Tutorials.”
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Figure 3-22. Run Macro tab.

Macro Recording Tips
If your macro accesses a third-party application, make sure that the application is 
open. Before you begin to record the macro, make a test run with the third-party 
application, writing down all of the keystrokes required for the tasks you wish to 
perform.

Avoid using the tab or arrow keys in your macro because the cursor may not 
always be in the same position each time a window opens. Rather, use keyboard 
shortcut keys to perform actions in the application.

Shortcut keys are indicated by an underlined letter in the button name, field name, 
or description. You press Alt, Ctrl, or Shift plus the underlined letter to perform 
the action. For instance:

In this case, pressing Alt-W clicks the Work Flow button.

NOTE:  The exact keystrokes for a keyboard shortcut are listed in the 
application’s menu. For instance, in Microsoft Word, to find out what the 
shortcut is to save a document, choose File from the menu bar. On the 
drop-down menu the Save option is followed by its shortcut, Ctrl-S.
3-38 October 29, 2004



Work Flow
Common Windows shortcut keys are:

A macro may include keystrokes for multiple applications. For example, one 
macro may include keystrokes for word processing, spreadsheet, and database 
applications. To switch between applications when recording a macro, use the 
mouse to select the application. Do not press Alt-Tab. If you do, these keystrokes 
are recorded and may not select the correct application when you play back the 
macro.

NOTE:  Do not press Ctrl-Esc to click the Microsoft Windows Start button, 
or the Macro Recorder stops recording without providing a message 
showing that recording has stopped. All keystrokes recorded up to this 
point are deleted. To click Start without causing an error or stopping 
recording, use your mouse.

Allowable Macro Keystrokes

Shortcut Key Description

Esc Cancels an action.

Enter Clicks OK or the default button in a dialog box. 
(Default buttons have a heavier border surrounding 
them.)

Ctrl-A Selects all text.

Ctrl-C Copies selected text to the clipboard.

Ctrl-P Prints the document.

Ctrl-S Saves the document.

Ctrl-V Pastes text into the window at the cursor position.

Ctrl-X Cuts selected text to the clipboard.

Key Type Key Macro Notation

Character 0 1 2 3 4 5 6 7 8 9

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

* + ; = , - . / ` [ \ ] '
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Non-Character Tab [TAB]

Backspace [BACKSPACE]

Enter/Return [ENTER]

Shift [SHIFT]

Control/Ctrl [CONTROL]

Alt [ALT]

Pause/Break [PAUSE]

Caps Lock [CAPSLOCK]

Esc [ESC]

Space/Space Bar [SPACE]

Page Up/PgUp [PAGE-UP]

Page Down/PgDn [PAGE-DOWN]

End [END]

Home [HOME]

Left Arrow [LEFT-ARROW]

Up Arrow [UP-ARROW]

Right Arrow [RIGHT-ARROW]

Down Arrow [DOWN-ARROW]

Print Scrn [PRINTSCREEN]

Insert [INSERT]

Delete [DELETE]

F1 through F24 [F1] … [F24]

Key Type Key Macro Notation
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Recording Macros

To record a macro:

1. Start any third-party applications you want to include in the new macro, 
and then minimize them.

2. Choose the appropriate work flow group in the Desktop Administrator left 
pane, and then click Work Flow.

The Work Flow Setup window appears.

3. Under the Actions pane, click Add.

The Select Action dialog box appears.

4. On the Run Macro tab, click New.

The New Macro dialog box appears.

5. Enter a new macro action name, and then click OK. 

The Macro Editor window appears (Figure 3-23).

Special Command Description

[ENTERPRISE FIELD:] Inserts an Enterprise Data field.

[DATA FIELD:] Inserts data from Agent Desktop.

[SYSTEM FIELD:] Inserts data from Agent Desktop system fields.

[APPLICATION:=] Changes focus to an application window. The equal 
sign ( = ) is used as a separator between the 
application and the window title. If either the 
application name or window title is missing, Agent 
Desktop attempts to find the correct application and 
window to play the macro to, based on the 
parameters present.

[DELAY] Time, in milliseconds, to wait before performing the 
next macro command.

Example: [DELAY] 1000 delays the next macro key 
or command by 1 second.
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Figure 3-23. Macro Editor window (with a macro script displayed).

6. Click Record. 

The Macro Editor window minimizes and the macro recorder starts. 
Anything you type from now on is entered in the new macro.

7. Maximize the third-party application and begin typing.

The macro recorder records your keystrokes.

8. If you wish to insert an Agent Desktop data field into the macro, press the 
Pause Macro hot key (default is F2). 

The Macro Recorder Suspended dialog box appears (Figure 3-24). 

Figure 3-24. Macro Recorder Suspended dialog box.
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9. Click Insert Data.

The Select a Data Field dialog box appears (Figure 3-25). See “Data 
Fields” on page 3-44 for more information.

Figure 3-25. Select a Data Field dialog box.

10. Choose the desired data field from the list, enter test data if desired, and 
then click OK. 

The test data you enter is displayed in the application only when the macro 
is tested using the Playback function.

The Macro Recording Suspended dialog box appears.

11. Click Resume Recording to continue recording the macro.

12. Once you have finished recording the macro, press the macro hot key.

The Macro Recording Suspended dialog box appears.

13. Click End Recording.

You are returned to the Macro Editor window. 

14. You can take the following actions:

■ Click OK to save the macro as recorded.

If there are no errors, the macro is saved and you are returned to the 
Select Action dialog box. 

If there are errors, the macro editor displays the line and highlights 
the text in question. Correct it and click OK again. 

■ Click Playback to test the macro.

If there are errors, the macro editor displays the line and highlights 
the text in question. Correct it and click Playback again.
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If there are no errors, the macro is played back. If it works as you 
want it to, click OK to save it and return to the Select Action dialog 
box.

To change test data, choose Data > Change Test Data in the 
macro editor and enter new test data.

■ Click Cancel to cancel the macro.

The macro is canceled and the Select Action dialog box appears.

Data Fields
The Select a Data Field dialog box (Figure 3-25) enables you to select and insert 
an Agent Desktop data field into a macro. Access this dialog box either through 
the Suspend Macro Recording dialog box or from the Data menu in the Macro 
Editor window.

There are three types of data fields:

■ Standard. Data from the switch.

■ System. System data, for example the date and time. These fields are 
enclosed in square brackets [ ].

■ Enterprise. Data from the Enterprise server.

Fields marked with an asterisk ( * ) denote data from CTI Enterprise. If Enterprise 
is not installed, these fields are not available.

NOTE:  When selecting data fields to be used in actions or rules, keep in 
mind that not every data field is available for every event. For example, the 
calling number is not available during the Startup event. If an unavailable 
field is used, <N/A> is displayed in the application the macro pops.

Call Control Actions

Call Control actions assign a call control to an event. 

To set up a new call control action:

1. In the Work Flow Setup window (Figure 3-18), choose the event to 
associate with the new action.

2. Under the Actions area, click Add.

The Select Action dialog box appears.

3. Choose the Call Control tab, and then click New.

The Setup Call Control Action dialog box appears (Figure 3-26).
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Figure 3-26. Setup Call Control Action dialog.

4. Enter the following information, and then click OK.

■ A name for the call control action.

■ The type of action. (Select from the drop-down list.)

■ A phone number if required by the type of action. (For example, for 
Blind Transfer, enter the phone number to which a call is 
transferred.)

NOTE:  You can add delays in the call control action by inserting commas 
in the dial string in the Phone Number field. Each comma is approximately 
a 1.5-second delay. Delays are useful if you must also enter touch tones 
during the call.

The Select Action dialog box appears. The new call control action has 
been added to the list of available actions.

Launch External Application Action

Launch actions start a third-party application in a new window. 

To ensure applications are running before macros attempt to use them, start them 
with launch actions assigned to the Startup event.

NOTE:  An application started by a launch action must use the same path 
on the agent’s PC as it does on the administrator’s PC or it must be on a 
network drive, or the launch action will not be successful.

When using launch actions, Agent Desktop can pass parameters, such as 
command line arguments, in two ways. 

The first method is to add parameters after the application path name. For 
example, the command to start Microsoft Excel and open a spreadsheet named 
mrmtest.xls is:
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“c:\program files\excel.exe” “c:\my documents\mrmtest.xls”

Program names and command line arguments that contain spaces must be in 
quotes so that they appear as one argument rather than as multiple arguments.

The second method involves passing data fields as arguments. You can pass any 
valid data field while launching an application. Remember though, that if a launch 
action takes place on the Startup event, call data may not be present. Empty or 
blank data fields will contain the string <NULL>.

To set up a new Launch External Application action:

1. In the Work Flow Setup window (Figure 3-18), choose the event to 
associated with the new action.

2. Under the Actions pane, click Add.

The Select Action dialog box appears.

3. Choose the Launch External Application tab, and then click New.

The Setup Launching External Application Action dialog box appears 
(Figure 3-27).

Figure 3-27. Setup Launching External Application Action dialog box.

4. Enter a name for the action and enter the path to the desired application’s 
location.

Make sure the application is located so that it is available to Agent 
Desktop at runtime.
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5. Add any arguments you wish to pass to the application. 

Choose the desired argument in the Available Arguments list, and use the 
left arrow to add it to the Argument list. Use the up and down arrows to 
reorder the Argument list.

6. When you have finished entering information, click OK. 

The Select Action dialog box appears. The new Launch External 
Application action has been added to the list of available actions.

For more examples of setting up this type of action, see Chapter 6, “Tutorials.”

Agent State Action

Agent State actions enable you to select an agent state to associate with an 
event.

NOTE:  You can change agent states only on ACD calls, not non-ACD 
calls.

To set up a new agent state action:

1. In the Work Flow Setup window (Figure 3-18), choose the event to 
associate with the new action.

Agent State actions may be associated only with Answered and Dropped 
events.

2. Under the Actions pane, click Add.

The Select Action dialog box appears.

3. Choose the Agent State tab, and then click New.

The Setup Agent State Action dialog box appears (Figure 3-28).

Figure 3-28. Setup Agent State Action dialog box.

4. Enter a name for the action, select the agent state control from the 
drop-down list, and then click OK. 

The Select Action dialog box appears. The new Agent State action has 
been added to the list of available actions.
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Utility Action

Utility actions set up actions such as starting and stopping recording or sending 
a predefined, high-priority chat message to the agent’s supervisor.

High-Priority Chat Messages.   A high-priority chat message is a popup dialog 
box that contains a predefined message (see Figure 3-29). You can configure a 
task button on the Agent Desktop to send such a message from an agent to the 
agent’s supervisor(s). The agent can send a high-priority message only when on 
an active call.

Figure 3-29. Sample high-priority chat message.

To set up a new utility action:

1. In the Work Flow Setup window (Figure 3-18), choose the event to 
associate with the new action.

2. Under the Actions pane, click Add.

The Select Action dialog box appears.

3. Choose the Utility Action tab, and then click New.

The Setup Utility Action dialog box appears (Figure 3-30).

Figure 3-30. Setup Utility Action dialog box.

4. Enter a name for the new action, and select an action type from the 
drop-down list.
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■ If you select Record as the action type, select Start or Stop from 
the Action field. 

■ If you select HighPriorityChat, type the message you want to send 
as the predefined, high-priority chat message in the Message field.

NOTE:  When the dialog box initially opens, only the Action Name and 
Action Type fields are visible. When you choose the Record action type, 
the Action field appears. When you choose the High Priority Message 
action type, the Message field appears.

5. Click OK.

The Select Action dialog box appears. The new Agent State action has 
been added to the list of available actions.
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Enterprise Data

The Enterprise Data Setup dialog box configures whether an agent is able to view 
the Enterprise Data window, and what information is displayed in that window.

When Enterprise Data is fully enabled, the agent can view both enterprise data 
and call activity data. See Figure 2-2 on page 2-4 for an illustration of the 
Enterprise Data window.

Data Tab

The Data tab (Figure 3-31) shows/hides the Enterprise Data window on the 
agent’s desktop and controls whether or not the agent can edit the enterprise 
data displayed in it.

Figure 3-31. The Data tab.

Field Description

Show Enterprise Data Check to enable agents to view enterprise data.

Allow agent to edit 
Enterprise Data

Check to enable agents to edit the enterprise data 
displayed.
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Window Options Tab

The Window Options tab (Figure 3-32) enables you to set the behavior of the 
Enterprise Data window on the agent’s desktop. Options are:

Figure 3-32. The Windows Options tab.

Option Description

Normal Enterprise Data appears when calls are present and 
minimizes when idle.

Keep Open Enterprise Data is always visible, but may be hidden 
by other open applications.

Always on Top Enterprise Data is always visible and on top of other 
open applications.

Stealth Enterprise Data appears as an icon in the system 
tray.
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Call Activity Tab

The Call Activity tab enables you to set the thresholds for call duration at a 
particular type of device (CSQ [contact service queue] and Agent) while a call is 
in the contact center.

NOTE:  The CSQ field displays the amount of time the call spent in queue 
prior to being delivered to the agent. The Agent field displays the amount 
of time that the call is at the agent device, including ring time. 

If a call remains at a device longer than the defined Caution or Warning threshold, 
a Caution or Warning icon is displayed next to the device name in the call activity 
pane of the Enterprise Data window.

NOTE:  You must enter threshold times in the Warning fields before 
entering threshold times in the Caution fields. Desktop Administrator will 
not accept data entered in the Caution fields if no data appears in the 
Warning fields.

NOTE:  The Warning threshold value must be greater than the Caution 
threshold value. If you enter a greater value in the Caution field, Desktop 
Administrator automatically changes it so that it is one second less than 
the Warning value.

Check the Show Call Activity check box to enable the agent to view call activity 
data in the Enterprise Data window.

Figure 3-33. The Call Activity tab.
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ICD Configuration
Introduction

ICD Configuration enables you to access applications used to administer your 
contact center. The ICD Configuration node appears in the Navigation tree of the 
left pane of the Desktop Administrator interface (Figure 4-1).

The nodes under the ICD Configuration node vary according to the makeup of 
your contact center. Some are set up during installation, and others may be 
added at a later time.

Figure 4-1. Sample ICD Configuration navigation tree.

Each item underneath a node is a hyperlink to a website or an application. 

■ The list under CallManager contains a link to the Cisco CallManager 
Administration website for each separate CallManager installation you 
have. 

■ The list under CRA contains a link to the Cisco Customer Response 
Application Administration website for each IP IVR installation you have.

When you click one of the hyperlinks, your web browser is launched and you are 
prompted to enter the user name and password for that particular installation.
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Toolbar and Menu Bar

Toolbar

The ICD Configuration toolbar contains four buttons.

Move your cursor over a button to view a tooltip describing its function.

Menu Bar

ICD Configuration has the following menu options:

Button Name Description

New Adds a new hyperlink to the navigation tree

Delete Deletes the selected hyperlink from the 
navigation tree

Properties Displays the selected hyperlink’s properties

About Displays copyright and version information for 
ICD Configuration

Option Description

File

New Adds a new hyperlink

Delete Deletes a hyperlink

View Hides/shows the ICD Configuration toolbar

Window Toggles your control from one pane to the other

Help Accesses online help and copyright and version 
information
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Managing Hyperlinks

Adding a New Hyperlink

You can add hyperlinks to the navigation tree for easy access to frequently-visited 
websites.

To add a new hyperlink:

1. Click the ICD Configuration node or one of its subnodes, and then click 
New on the toolbar or choose File > New on the menu bar.

The New URL dialog box appears (Figure 4-2).

Figure 4-2. New URL dialog box.

2. Enter a display name and the URL of the destination website, and then 
click OK.

The new hyperlink appears under the node you selected in Step 1.

Renaming and Deleting Hyperlinks

You can rename and delete hyperlinks on the navigation tree. 

To rename a hyperlink:

1. Right-click the hyperlink you want to rename.

The shortcut menu appears.

2. Choose Rename, type the new name, and then click outside the hyperlink 
or press Enter.

The hyperlink is renamed.
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To remove a hyperlink:

1. Right-click the hyperlink you want to delete.

The shortcut menu appears.

2. Choose Delete.

The hyperlink is deleted.
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Personnel Configuration
Introduction

Personnel Configuration enables you to:

■ View agent properties

■ Assign supervisors to teams

■ Set up and maintain teams

You can use Desktop Administrator to set up teams, and to assign agents as 
supervisors to teams, but you cannot use Desktop Administrator to set up and 
maintain agents. (Agents are set up and maintained on the ICD server.).
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Toolbar and Menu Bar

Toolbar

The Personnel Configuration toolbar contains five buttons. 

Move your cursor over a button to view a tooltip describing its function.

Menu Bar

Personnel Configuration offers the following menu bar options:

Button Name Description

New Adds a new team

Delete Deletes the selected team

Web Opens your web browser and accesses the 
Cisco Customer Contact Solutions website

Help Accesses online help

About Displays copyright and version information

Option Description

File

New Adds a new team

Delete Deletes the selected team

View Shows/hides the Personnel toolbar

Window Toggles your control from one pane to the other

Help Accesses online help and copyright and version 
information
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Agents

The Agents window (Figure 5-1) displays a list of all the agents configured in the 
ICD server.

From this window you can view an agent’s properties (user ID, password, display 
name, and team name, all of which are administered in ICD) and change an 
agent’s work flow group affiliation. 

Figure 5-1. The Agents window.

To view agent properties:

1. Select the agent from the agent list, and then click Properties.

The Agent Properties dialog box appears (Figure 5-2).

2. View the agent properties, and then click OK.
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To change an agent’s work flow group:

1. Select the agent from the agent list, and then click Properties.

The Agent Properties dialog box appears (Figure 5-2).

2. Select a work flow group from the drop-down list, and then click OK.

The agent is now assigned to a new work flow group.

Figure 5-2. Agent Properties dialog box.

Field Description

User ID Agent’s Agent Desktop user ID

Password Agent’s Agent Desktop password

Display name Agent’s name

Team name Team to which the agent is assigned

Work flow group Work flow group that controls the agent’s desktop 
and work flow configuration
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Supervisors

The Supervisors window (Figure 5-3) displays a list of all the supervisors available 
to be assigned to a team. These supervisors are chosen from the list of agents 
set up in the ICD server. 

You can add or remove a supervisor and view a supervisor’s properties from this 
window.

Figure 5-3. The Supervisors window.

To add a supervisor:

1. Click the Add button.

The Supervisor Properties dialog box appears (Figure 5-4).

2. Select the new supervisor’s user ID from the User ID drop-down list.

This list contains the user IDs of every agent in the ICD server. When you 
select the user ID, the agent’s name appears in the Display name field.

3. Click OK.

The supervisor’s name is listed in the Supervisors window.
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Figure 5-4. The Supervisor Properties dialog box.

To remove a supervisor:

■ Choose the supervisor you want to delete from the Supervisors list, and 
then click Remove.

The agent is removed as a supervisor. 

NOTE:  Removing an agent from the list of supervisors does not remove 
the agent from the ICD server.

Field Description

User ID Supervisor’s Supervisor Desktop user ID.

Display name Supervisor’s name.

Team/Type pane Team the supervisor is assigned to, and the type 
(primary or secondary) of supervisor. Supervisors are 
assigned to teams using the Supervisors tab (see 
“Supervisors Tab” on page 5-9).
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To view a supervisor’s properties:

1. Select the supervisor from the supervisors list, and then click Properties.

The Supervisor Properties dialog box appears (Figure 5-4).

2. View the supervisor’s properties, and then click OK.

The Supervisor Properties dialog box closes.
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Teams

The Teams window (Figure 5-5) enables you to set up the supervisors, agents, 
and contact service queues for a particular team. 

The lists of agents and contact service queues come from the ICD server; 
supervisors are set up under the Supervisors node. (See “Supervisors” on page 
5-5.)

Figure 5-5. The Teams window.

Adding and Deleting Teams

You can add or delete a team to the list displayed under the Teams node.

To add a new team:

1. Choose the Team node or any of the subnodes beneath it.

2. Choose File > New from the menu bar or click the New button on the 
toolbar.

The Team Identification dialog box appears (Figure 5-6).
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Figure 5-6. The Team Identification dialog box.

3. Enter a name for the new team, and then click OK. 

The team name can include alphanumeric characters, spaces, and 
underscores. Do not use special characters (asterisks, forward or back 
slashes, etc.).

The new team is added to the list of teams in the Navigation pane of the 
Desktop Administrator window. You can now configure the agents, 
supervisors, and contact service queues for the new team.

To remove an existing team:

1. Choose the team you want to delete in the Navigation pane of the Desktop 
Administrator window.

2. Choose File > Delete from the menu bar or click the Delete button on the 
toolbar.

A dialog box appears asking you to confirm your deletion.

3. Click Yes to confirm deleting the team. 

The team is deleted from the list of teams in the left pane.

NOTE:  You cannot delete the Default team. 

Supervisors Tab

The Supervisors tab in the Teams window (see Figure 5-5) displays the:

■ Primary supervisor

■ Secondary supervisors

■ Available supervisors

The list of available supervisors includes any agent tagged as a supervisor. (See 
“Supervisors” on page 5-5.) Supervisors can be assigned to multiple teams.

It is recommended that each team have a primary supervisor, although it is not 
required. Secondary supervisors are optional.
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NOTE:  Primary and Secondary Supervisors have the same rights. Both 
types of supervisors can monitor, record, barge-in, and intercept an 
agent’s calls. 

To set up a team’s primary and secondary supervisors:

1. Select a primary supervisor from the Primary supervisor drop-down list. 

2. Select a secondary supervisor from the Available supervisors pane, and 
then click the left arrow to add the supervisor to the Secondary 
supervisors pane. 

You can add as many secondary supervisors as you wish. 

Use the right arrow to move a secondary supervisor back to the Available 
supervisors pane.

3. When you have finished assigning the primary and secondary supervisors 
to the team as desired, click Apply.

The supervisors are assigned to the team.

Agents Tab

The Agents tab of the Teams window (Figure 5-7) displays the:

■ Agents selected for the team

■ Agents available to be assigned to the team

The list of available agents include the agents who have not yet been assigned to 
a team. An agent can belong to only one team at a time.

NOTE:  All agents initially belong to the Default team. If an agent is 
removed from a team you created and not reassigned to another, the agent 
moves back to the Default team.

NOTE:  When you move an agent from one team to another, in order for 
the agent to show up on the correct team in Supervisor Desktop, the agent 
must be logged out and then logged back in. 
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Figure 5-7. The Agents tab.

To add an agent to a team:

1. Select an agent from the Available agents pane and click the left arrow to 
add the agent to the Selected agents pane. 

You can add as many agents as you wish. 

2. Click Apply.

The agent is added to the team.

NOTE:  If you wish to add an agent who is currently assigned to another 
team, you must first remove that agent from the other team, and then add 
the agent to the new team.

To remove an agent from a team:

1. Choose the agent to be removed from the Selected agents pane, and then 
click the right arrow.

The agent is moved from the left pane to the right pane.

2. Click Apply.

The agent is removed from the team.
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Contact Service Queues Tab

The Contact Service Queues tab of the Teams window (Figure 5-8) displays the:

■ Queues assigned to the team

■ All available queues

The list of available queues includes every queue set up on the ICD server. 
Queues can be assigned to multiple teams.

Figure 5-8. The Contact Service Queues tab.

To add a contact service queue to a team:

1. Select a contact service queue from the Available queues pane, and then 
click the left arrow.

The queue is moved to the Selected queues pane. 

You can add as many queues as desired.

2. Click Apply.

The contact service queue is added to the team.
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To remove a contact service queue from a team:

1. Select the contact service queue to be removed from the left pane, and 
then click the right arrow. 

The queue is moved to the right pane.

2. Click Apply.

The contact service queue is removed from the team.
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Tutorials
Introduction

This chapter shows you how to perform several common tasks. The tasks are 
presented as tutorials, and each task includes step-by-step instructions, sample 
screens, and keystroke macro examples. 

The tutorials are based on a fictional company called Rock Coast Products. The 
tutorials are:

■ Setting up an ANI-based screen pop 
Search a Microsoft Outlook contact list for the ANI.

■ Using a terminal emulator package 
Use terminal emulation software to find the caller’s name based on the ANI 
and then create an e-mail message using Microsoft Outlook.

■ Setting up a task button to transfer to a specified number
Set up a task button that allows agents to transfer calls to their 
supervisors.

■ Setting up a task button for after-call work
Set up a task button that creates a Microsoft Outlook e-mail message for 
after-call work.

■ Setting up a Launch External Application action
Set up an action that automatically launches a third-party application.

■ Using wild card data conditions
Use wild card data conditions when setting up rules.

Detailed information about Desktop Administrator’s macro recording capabilities 
is found on page 3-37. 

NOTE:  Macros may need fine-tuning, depending on the PC used and the 
third-party software accessed.
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Setting Up an ANI-Based Screen Pop

Premise
Rock Coast Products wants to use the ANI as the basis for a screen pop 
containing customer contact information.

Procedure
Set up a macro to search for the ANI in a Microsoft Outlook 2000 contact list.

NOTE:  This example uses Microsoft Outlook 2000 SR-1(9.0.0.3821). If 
you have a different version, your keystrokes may vary.

1. Open Outlook. 

2. In the Navigation pane of Desktop Administrator, click Desktop 
Configuration > Work Flow Groups > Agents, and then select a work 
flow group.

3. Click Work Flow.

The Work Flow Setup window appears.

4. Select Ringing from the Events list box, and then click New under the 
Rules area.

The New Rule Name dialog box appears.

5. Enter a name (for example, CustContact), and then click OK.

The Work Flow Setup window appears.

The new rule appears in the Rules list.

6. Select the new rule, and then click Edit next to the first Data Field 
Conditions field.

The Data Field Conditions dialog box appears.

7. Select Calling# from the Data Field drop-down list, check the Enable 
Condition check box, check the Is Not Empty data field filter, and then 
click OK.

The Work Flow Setup dialog box appears.

8. Check the Enable Rule check box, and then choose Any Condition is 
True.

9. Click Add to create a new action for the event.

10. In the Select Action dialog, Select the Run Macro tab and click New.

11. In the New Macro dialog, enter a new macro action name (for example, 
LookUpPhoneNumber) and click OK.
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12. In the Macro Recorder dialog, note that the macro name entered in step 5 
appears in the title bar. Click Record.

The Macro Recorder dialog minimizes.

13. Maximize Outlook and begin typing the following macro keystrokes; the 
Macro Recorder records your keystrokes.

14. Click Insert Data and select the CALLING# data field from the list.

15. Click Resume Recording and enter the remaining macro keystrokes, 
shown below.

16. The macro is now complete. To test it, click Playback.

You can make changes to the macro in the edit window, and you can test 
the changes by clicking Playback.

Macro Keystrokes Action

ALT + V Access the View menu

G Select Go to…

O Select Contacts

ALT + T Access the Tools menu

D Select Advanced Find

ALT + C Moves the cursor to the Search for the 
word(s) field

Press F2 (or whichever key 
has been set up as the macro 
hot key)

Pause macro recording and bring up the 
Macro Options dialog

Macro Keystrokes Action

ALT + I Selects the In field

P Toggles to the Phone number fields 
only option

ALT+N Clicks the Find Now button

Press F2 (or whichever key 
has been set up as the macro 
hot key)

Pause macro recording and bring up the 
Macro Options dialog
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NOTE:  You might see multiple [ALT] entries in the macro. These are 
extraneous and can be deleted. If left in the macro, they will not cause 
errors.

17. Once you are satisfied with the macro, click OK to save and add it to the 
list of available macros that can be selected as actions.

18. Select the new macro and click OK. 

The Work Flow dialog appears. Notice that the macro has been added to 
the list of actions for the selected rule and event.

Macro Text
The following text appears in the macro recorder dialog:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[ALT] V
G
O
[ALT] T
D
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] C
[DATA FIELD:CALLING#]
[ALT] I
P
[ALT] N

Now you must record a second macro to close the Advanced Find dialog. Make 
sure to keep Outlook and the Advanced Find dialog open.

1. In the Work Flow Setup dialog, select Dropped from the Events list box.

2. Under the Actions list, click New to create a new action.

3. In the Select Action dialog, Select the Run Macro tab and click New.

4. In the New Macro dialog, enter a new macro action name (for example, 
CloseAdvFind) and click OK.

5. In the Macro Recorder dialog, note that the macro name entered in step 5 
appears in the title bar. Click Record.

The Macro Recorder dialog minimizes.
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6. Maximize the Advanced Find dialog and begin typing the following macro 
keystrokes; the Macro Recorder records your keystrokes.

NOTE:  You must add a delay at the beginning of the macro. See “Macro 
Text” below.

7. Once you have finished recording the macro, press the macro hot key to 
bring up the Macro Options dialog, and then click End Recording.

8. To test your macro, click Playback.

9. Once you are satisfied with the macro, click OK to save and add it to the 
list of available macros that can be selected as actions.

10. Select the new macro and click OK.

The Work Flow dialog appears. Notice that the macro has been added to 
the list of actions for the selected rule and event.

Macro Text
The following text appears in the macro recorder dialog:

[DELAY] 1500
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] F
C

Macro Keystrokes Action

ALT+F Access the File menu

C Close the Advanced Find dialog

Press F2 (or whichever key 
has been set up as the macro 
hot key)

Pause macro recording and bring up the 
Macro Options dialog
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Using a Terminal Emulator Package

Premise
Rock Coast Products would like to use a terminal emulation program to find the 
caller’s name based on the ANI, and then automatically create an email message 
each time a call is received.

Steps
This example uses the following software:

■ Terminal emulation software: HostExplorer for Windows 95/98, file version 
6.1.0.0. from Hummingbird Communications Ltd.

■ Email program: Microsoft Outlook 98 (8.5.5104.6)

Use two macros since they can potentially be reused with other actions. It is 
easier to create and debug small macros and then run them as two actions in a 
sequence to do larger tasks. 

■ The first macro accesses the terminal emulation program and copies the 
caller’s name to the clipboard.

■ The second macro copies the number from the clipboard and uses it in an 
email message.

NOTE:  Terminal emulation packages can be unpredictable when used 
with macros. The keyboard/terminal emulation must be correct for the 
macros to record and play back correctly. Some terminal emulation 
packages do not have a provision for highlighting and copying text from a 
screen.

Make sure both programs are running before recording the macros. Also make 
sure that the terminal program is logged in to a server, and open a text file using 
Vi (Unix editor). The text file layout is shown below:

Phone Number Name
612-971-2000 Spanlink Communications
612-555-1234 John Smith
612-555-0000 Mary Nelson
612-555-5555 Ned Marvin

Set up the Vi macro:

1. Open Vi, log into the server, and open the text file.

2. Run Desktop Administrator, click Work Flow and add a new action for the 
Ringing event.

3. In the Select Action dialog, click New in the Run Macro dialog.
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4. Enter a new macro action name (for example, GetNamePutInClipBoard) 
and click OK.

5. In the Macro Recorder dialog, click Record. The Macro Recorder dialog 
minimizes.

6. Maximize Vi, and begin typing the following macro keystrokes; the Macro 
Recorder records your keystrokes.

7. Select the Insert Data option and then select the data field you wish to 
insert.

8. Click Resume Recording in the Macro Options dialog. Begin typing the 
following keystrokes.

Macro Keystrokes Action

H Place the cursor in the “home” position

/ Search

F2 (or whichever key has 
been set up as the macro hot 
key)

Pause macro recording and bring up the 
Macro Options dialog

Macro Keystrokes Action

ENTER Search

Positioned on the Phone Number field

/ Search

<SPACE> Search for a space to get to the Name 
column

ENTER Search

Positioned after the Phone Number field

L Move right one character (over the first 
space)

L Move right one character (over the second 
space)
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9. Once you have finished recording the macro, press the macro hot key to 
bring up the Macro Options dialog, and then click End Recording.

10. To test your macro, click Playback. You can make changes to the macro in 
the Edit window, and you can test the changes by clicking Playback.

11. Once you are satisfied with the macro, click OK to save and add it to the 
list of available macros that can be selected as actions.

12. Select the new macro and click OK.

The Work Flow dialog appears. Notice that the macro has been added to 
the list of actions for the selected rule and event.

After you have recorded both macros, notice that both appear in the Work Flow 
dialog. Make sure that they appear in the order shown in Figure 6-1.

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

The next three key stroke combinations 
select the caller’s name

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[ALT] E Vi Edit menu

C Copy the selected text to the clip board

Press F2 (or whichever key 
has been set up as the macro 
hot key)

Pause macro recording and bring up the 
Macro Options dialog
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Figure 6-1. Work Flow Setup dialog box.

Vi Macro Text
The following text appears in the macro recorder dialog box:

[APPLICATION:HOSTEXPLORER=1 - DEFAULT (DEACON)]
[SHIFT] H
/
[DATA FIELD:CALLING#]
[ENTER]
/
[SPACE]
[ENTER]
L
L
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[ALT] E 
C

Outlook Macro Text
The following text appears in the macro recorder dialog:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[SHIFT] [CONTROL] B
[APPLICATION:ABCLS=ADDRESS BOOK]
[ALT] Y 
[CONTROL] V
[CONTROL] N
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[SHIFT] R
E
G
A
R
D
I
N
G
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] C
A
L
L
[SPACE]
O
N
[SPACE]
[SYSTEM FIELD:CALL_START_TIME]
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[CONTROL] V
.
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Setting Up a Task Button to Transfer 
to a Specified Number

Premise
Rock Coast Products wants to set up a call control button that will allow agents 
to easily transfer calls to their supervisor.

Steps

1. In Desktop Administrator, click Desktop Configuration—Work Flow 
Groups—Agents and select a work flow group.

2. Click User Interface.

3. On the User Interface Setup window’s Toolbar tab, select the task button 
you want to configure.

4. Select the Visible check box.

5. Type a brief hint to describe the action (for instance “Xfer to Super”) in the 
hint field.

6. Click Add.

7. In the Select Action dialog, select the Call Control tab and click New.

8. In the Setup Call Control Action dialog, enter a name for the action in the 
Action Name field, select the call control type, and enter the supervisor’s 
telephone number in the Phone Number field.

9. Click OK to save the settings.

10. On the Call Control tab, the new action is highlighted. Click OK to return 
to the User Interface Setup window.

11. In the User Interface Setup window’s Toolbar tab, the new action is now 
associated with the task button you are configuring.

12. Click OK to save the changes.
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Setting Up a Task Button for 
After-Call Work

Premise
Rock Coast Products wants to set up a task button that prepares a Microsoft 
Outlook 2000 email message for after-call work.

This example retrieves customer information (email address, name, and amount of 
sale) from an Access 2000 database and pastes that information into an Outlook 
2000 email. 

Assumptions:

■ The agent has been looking at the customer’s record in the Access 
database in form view

■ Outlook is open on the agent’s desktop and is displaying the In Box.

■ The agent reviews the automatically-generated email and sends it 
manually.

Steps

1. In Desktop Administrator, click Desktop Configuration—Work Flow 
Groups—Agents and select a work flow group.

2. Click User Interface.

3. On the Use Interface Setup window’s Toolbar tab, select the task button 
you wish to configure.

4. Select the Visible check box.

5. Type a brief hint to describe the action (for instance “After Call Email”) in 
the hint field.

6. Click Add.

7. In the Select Action dialog, select the Run Macro tab and click New.

8. In the New Macro dialog, type a name for the new macro (for instance, 
“AfterCallEmail”) and click OK.
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9. In the Macro Recorder dialog, click Record to start recording the macro.

Macro Keystrokes Action

(maximize Access)

[HOME] Press Home to position the cursor in the 
first field in the form.

[TAB] Press the tab as many times as needed 
to go to the email address field.

[CONTROL] C Copy the email address.

(maximize Outlook)

[CONTROL] N Open a blank email message.

[CONTROL] V Paste the email address in the To: field in 
the email message.

[TAB] Tab down to the Subject line.

{TAB}

[SHIFT] Y Type “Your Order” in the Subject line.

O

U

R

[SPACE]

[SHIFT] O

R

D

E

R

[TAB] Tab to the body of the message.
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[SHIFT] D Type the salutation “Dear ”

E

A

R

[SPACE]

(maximize Access)

[TAB] Tab as many times as needed to get to 
the Name field.

[CONTROL] C Copy the customer’s name.

(maximize Outlook)

[CONTROL] V Paste the customer’s name after the 
salutation.

[ENTER] Press the Return key twice to start a new 
line for the body of the message.

[ENTER]

[SHIFT] T Type the message: “Thank you for your 
order in the amount of “.

H

A

N

K

[SPACE]

Y

O

U

[SPACE]

F

O

Macro Keystrokes Action
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R

[SPACE]

Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

A

M

O

U

N

Macro Keystrokes Action
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T

[SPACE]

O

F

[SPACE]

(maximize Access)

[TAB] Tab as many times as needed to get to 
the Amount of Sale field.

[CONTROL] C Copy the amount of sale.

(maximize Outlook)

[CONTROL] V Paste the amount of sale in the body of 
the message.

. Add a period to the sentence.

[SPACE] Type “Your order is in the mail.” to finish 
the email.

[SHIFT] Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]

I

Macro Keystrokes Action
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10. Once you have finished recording the macro, press the macro hot key to 
display the Macro Options dialog, and then click End Recording.

11. To test your macro, click Playback. You can make changes to the macro in 
the edit window and then test them by clicking Playback again.

TIP:  To slow down the macro so you can watch the steps, insert the 
command [DELAY] 1000 before and after the commands for maximizing 
Outlook and Access. This will help you debug the macro. For instance:

[DELAY] 1000
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : 
FORM]
[DELAY]1000

12. Once you are satisfied with the macro, click OK to save and add it to the 
list of available macros that can be selected as actions.

13. On the Run Macros tab, the new macro is highlighted. Click OK to return 
to the User Interface Setup window.

S

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

M

A

I

L

.

Macro Keystrokes Action
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14. In the User Interface Setup window’s Toolbar tab, the new macro action is 
now associated with the task button you are configuring.

15. Click OK to save the changes.

Sample Macro Text
The following text appears in the macro recorder dialog:

[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : 
FORM]

[HOME]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[CONTROL] N
[APPLICATION:RCTRL_RENWND32=UNTITLED - MESSAGE (PLAIN 

TEXT) ]
[CONTROL] V
[TAB]
[TAB]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] O
R
D
E
R
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : 

FORM]
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[HOME]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN 

TEXT) ]
[CONTROL] V
,
[ENTER]
[ENTER]
[SHIFT] T
H
A
N
K
[SPACE]
Y
O
U
[SPACE]
F
O
R
[SPACE]
Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
N
[SPACE]
T
H
E
[SPACE]
A
M
I
[BACKSPACE]
O
U
N
T
[SPACE]
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O
F
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : 

FORM]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN 

TEXT) ]
[CONTROL] V
.
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
S
[SPACE]
I
N
[SPACE]
T
H
E
[SPACE]
M
A
I
L
.
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Setting Up a Launch External 
Application Action

Premise
Rock Coast Products wants to set up a task button that automatically launches a 
third-party application.

Steps
In this example you set up an action that launches Microsoft WordPad and then 
associate the action with a task button on the agent’s toolbar.

1. In Desktop Administrator, click Desktop Configuration—Work Flow 
Groups—Agents and select a work flow group.

2. Click User Interface.

3. On the User Interface Setup window’s Toolbar tab, select the task button 
you want to configure.

4. Select the Visible check box.

5. Type a brief hint to describe the action (for instance, “WordPad”) in the 
hint field.

6. Click Add.

7. In the Select Action dialog, select the Launch External Application tab and 
click New.

8. In the Setup Launching External Application Action dialog, enter a name 
for the action in the Action Name field and browse to the application’s 
executable (Wordpad.exe) in the Application field. Remember that the 
application should be located on a network drive so it is accessible to all 
agents. If you must use an application located on the agent’s PC, make 
sure that the application is accessible by an identical path on each agent’s 
PC.

9. If you want, add any of the available arguments to pass to WordPad. 
Select the arguments from the right-hand Available Arguments pane and 
use the left and right arrows to add or remove them to the left-hand 
Arguments pane. Use the up and down arrows to rearrange the order in 
which they will appear.

10. Click OK to return to the Launch External Application tab with the new 
action highlighted in the list of actions. 

11. Click OK to return to the User Interface Setup window.

12. In the User Interface Setup window’s Toolbar tab, the new action is now 
associated with the task button you are configuring.

13. Click OK to save the changes.
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Using Wild Card Data Conditions

Premise
Rock Coast Products is located in a city with two neighboring area codes. The 
east metro area code is 651 and the west metro area code is 612. Rock Coast’s 
Customer Service Division has an agent who assists east metro callers and one 
who assists west metro callers.

If an east metro caller dials the main Customer Service number, Rock Coast 
wants that call directed automatically to the appropriate agent.

Steps
To do this, Rock Coast sets up rules using the data conditions Is in the List and 
Is not in the List. These data conditions only return as true if there is an exact 
string match. 

Entering hundreds or even thousands of telephone numbers into a list is not 
feasible, so Rock Coast uses wild card data conditions. This is similar to using 
the Find tool in Windows—you can enter part of a string or a whole string to find 
what you’re looking for. 

Valid wild card strings are:

Use these steps to set up a wild card data condition that will transfer calls from 
the 651 area code to the east metro agent:

1. In Desktop Administrator, click Desktop Configuration—Work Flow 
Groups—Agents and select a work flow group.

2. Click Work Flow.

3. In the Work Flow Setup window, select the Ringing event.

String Description

ABC? Examples of matches: ABCD, ABCF, ABC1

The fourth character can be anything, but there must be only 
four characters in the string and the first three must be ABC.

??ABC Examples of matches: 12ABC, AAABC, ##ABC

The first two characters can be anything, but the last three 
must be ABC and there must be five characters in the string.

ABC* Examples of matches: ABCD, ABCDEF, ABC

The fourth through nth characters can be anything, but the 
first three characters much be ABC. 
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4. Under the Rules pane, click New.

5. Create a new rule named East Metro.

6. In the Work Flow Setup dialog, note that the new rule appears in the Rules 
list. With the new rule highlighted, click Edit next to the first Data Field 
Conditions field.

7. Select Calling# from the Data Field drop-down list.

8. Select Enable Condition.

9. Select Is in the list.

10. Add the wild card data condition 651* to the list.

11. Click OK.

12. Select Enable Rule.

13. Click OK.

[note: ask Kim about adding an action here (called Redirect)? Do we have to do a 
blind transfer to the East Metro agent’s extension?]
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Glossary
– A –

ACD
See automatic call distribution.

action
An occurrence that takes place when a rule is met. Actions include: running a 
macro, launching a third-party application, performing a call control, setting 
an agent state, or running a utility. More than one action can take place as a 
result of meeting a rule.

administration, central
The administration of groups of agents from a central PC.

administration, local
An option that allows an agent to program or administer some aspects of his 
or her Agent Desktop application.

agent
The person who interacts with customers in a contact center. 

Agent Desktop
The Cisco desktop application used by a contact center agent to handle 
customer calls.

agent state
An agent’s current status. Possible statuses are: Ready, Not Ready, Work, 
Reserved, Talking, Logged In, and Logged Out.

Agent State action
An action type that changes an agent’s agent state.
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agent state buttons
The buttons on the Agent Desktop interface used to change the agent’s 
current status. Available buttons are: Logged In, Logged Out, Ready, Not 
Ready, and Work.

Always on Top
A display mode in which the interface is always on top of all other windows 
and does not minimize.

Always Open
A display mode in which the interface is always visible, but may be hidden by 
other open applications.

ANI
See automatic number identification. 

Answer/Drop button
One of the call control buttons on the Agent Desktop interface. Clicking this 
button answers or drops the selected call.

Answered event
The event that occurs when the agent answers the phone.

appearance
A PBX line or extension that is on a multi-button–key telephone. For example, 
extension 445 appears on three-key systems.

area code
A 3-digit code designating a toll center in the United States and Canada.

automatic call distribution (ACD)
Optional software that resides on the PBX. Its role is to monitor various 
parameters within the system and call center and to intelligently route calls 
based on that information. 

automatic number identification (ANI)
A series of digits at the front of a phone call that delivers the billing number 
(which is not necessarily the phone number) of the caller.

– B –

barge-in
A feature in Supervisor Desktop that allows a supervisor to forcibly join an 
agent’s call with a customer.
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Barge-In button
The button on the Supervisor Desktop interface that allows a supervisor to 
forcibly join an agent’s call with a customer.

bridged appearance
A situation in which two devices share the same phone number (for example, 
a secretary whose phone can also answer the boss’s phone). 

– C –

call activity data
The information displayed in the Enterprise Data window documenting the 
length of time a call is at a particular type of device or agent within the call 
center. 

call center
A location where calls are made and answered. A call center typically has 
numerous agents and an automatic call distributor. 

call control
The action of changing the state of a call, for instance, making, answering, 
transferring, or dropping a call.

Call Control action
An action that performs a call control function triggered by an event meeting 
a rule. Call control actions vary according to switch type.

call control buttons
The buttons on the Agent interface that the agent uses to perform phone 
functions. Call control actions vary according to switch type.

call history
See call activity data.

call log
The record of calls made and received by a desktop while running Agent. 
This log is viewable in the Call Log Viewer within Agent Desktop. 

call routing
The automatic sending of calls to the desired destination, such as an 
extension or a queue.

call treatment
The handling of calls, for example, queuing the call or playing announcements 
to the caller.
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Call/Chat
The application that runs on the agent desktop. Call/Chat displays text 
messages and conference call information, and enables the agent to send 
messages to other agents and the supervisor.

Call/Chat server
A server program that handles the passing of data messages between agents 
and supervisors.

caller input
Touchtone data entered by the caller in response to prompting.

CallManager
A Cisco software-based voice-over IP telephone switch.

central office (CO)
The telephone company building where subscribers’ lines are joined to 
switching equipment that connects subscribers to each other, both locally 
and long distance.

chat name
The name by which an agent is known in the Call/Chat application.

chat session
A written exchange between agents or between agent and supervisor using 
the Call/Chat application.

CO
See central office.

computer telephony integration (CTI)
The connection of a computer with a telephone switch that allows the 
computer to issue commands and receive event information for calls and 
agents. 

Conference button
One of the call control buttons on the Agent Desktop interface. Clicking this 
button enables you to set up a conference call.

configuration file
The computer file that stores the settings of an application.

contact center
An expansion of a call center, so that it can make and receive not only phone 
calls, but email, faxes, web chat messages, and so on.
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CORBA
Common Object Request Broker Architecture. An architecture and 
specification for creating, distributing, and managing distributed program 
objects in a network. It allows programs at different locations and developed 
by different vendors to communicate in a network through an interface broker.

country code
The 1–3 digit code that, in the world numbering plan, identifies each country 
or integrated numbering plan in the world.

CTI
See computer telephony integration.

– D –

data field
A piece of information about a phone call that is available for display in the 
Agent Desktop interface. 

data field condition
A logical statement about call data that evaluates as either true or false.

data router
In networks, a device that connects any number of IP LANs.

data switch
In networks, a device that filters and forwards packets between LAN 
segments.

database
A collection of data structured and organized in a disciplined fashion so that 
information of interest can be accessed quickly.

deflected call
A ringing call that is redirected to another extension without being answered 
first.

delimiter
A word or character that marks the beginning or end of a segment of data.

Desktop Administrator
The application used to administer the Desktop product suite.

device
A unit (for example, a telephone) connected to the telephone system. 
October 29, 2004 7-5



Cisco Desktop Administrator 4.5 User Guide
Dial Pad
The soft phone screen that enables an agent to dial a number.

dial plan
A description of the dialing arrangements for customer use on a telephone 
network. For example, the local access code, local area code, etc.

dialed number information service (DNIS)
A telephony network feature that provides the number the caller dialed.

Directory Services server
An LDAP server. All other servers in the Desktop Product Suite system 
register with the Directory Services server at startup. Clients use this server 
to request information about other Desktop Product Suite components.

disconnect
The breaking or release of the connection between two telephones. A caller 
is disconnected when the other party hangs up on the caller.

DNIS
See dialed number information service.

drop
To hang up or disconnect a phone call.

Dropped event
An event which indicates a call is disconnected.

DTMF
See Dual Tone Multi-Frequency.

dual tone multi-frequency (DTMF)
The term for touchtone dialing. In DTMF, when you touch a button on a push 
button pad, it makes a tone which is actually a combination of two tones, one 
high frequency and one low frequency. These are the beeps you hear when 
you dial a phone number.

duplex environment
An operating environment that contains a primary and secondary server. If the 
primary server fails, the secondary server takes over.
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enterprise data
A piece of data available to the Desktop Product Suite via the Enterprise 
server.

Enterprise Data
The application used in conjunction with Agent Desktop to display the 
additional enterprise data associated with a call. 

Enterprise server
A server program that tracks calls in the system. It is used to attach 
IVR-collected data to a call in order to make real-time call activity data 
available at the agent desktop.

error code
A system or application-generated code that is displayed when a program 
error occurs. 

Ethernet
A local area network standard. Like other LAN technologies, Ethernet is used 
to connect computers, printers, workstations, terminals, servers, and other 
devices within the same building or campus.

event
An occurrence at the agent desktop. Events include: startup, shutdown, 
ringing, answered, and dropped. 

extension
The internal telephone number at the agent desktop. 

external application
A software application not belonging to the Desktop Product Suite. 

– F –

feature
The capability of a product to perform one or many tasks, for example, 
running macros, performing call control, or launching external applications.
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Hold/Unhold button
One of the call control buttons on the Agent Desktop interface. Clicking this 
button puts the selected call on hold or takes it off hold.

host
A server connected to a network.

– I –

ICD
See integrated contact distribution.

Install Manager
The program that helps you install the Desktop Product Suite on your system.

integrated contact distribution (ICD)
A voice-over IP ACD that works with CallManager. It has automated voice call 
distribution and contact interaction management for up to 75 concurrent 
agents. It integrates with Cisco IP IVR and IP Automated Attendant 
applications.

interactive voice response (IVR)
The use of a computer to interact verbally via a telephone with a caller. The 
computer plays announcements and questions to the caller, and the caller 
replies by entering information via touch tones, a rotary dial, or by speaking. 
“IVR” and “VRU” are often used interchangeably. See voice response unit 
(VRU).

intercept
An intercept occurs when a supervisor uses the Intercept button to force a 
transfer from an agent to the supervisor. 

Intercept button
The button on the Supervisor Desktop interface that allows a supervisor to 
force a call to be transferred from an agent to the supervisor.

Internet protocol (IP)
This protocol specifies the format of packets, also called datagrams, and the 
addressing scheme. Most networks combine IP with a higher-level protocol 
called transport control protocol (TCP), which establishes a virtual 
connection between a destination and a source.

IP by itself is something like the postal system. It allows you to address a 
package and drop it in the system, but there’s no direct link between you and 
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the recipient. TCP/IP, on the other hand, establishes a connection between 
two hosts so that they can send messages back and forth for a period of 
time.

IP
See Internet protocol.

IP address
The Internet protocol address of a device. 

IP phone
A phone that enables you to move multimedia traffic over any network that 
uses Internet protocol (IP).

IP port
In TCP/IP and UDP networks, an endpoint to a logical connection.

IP IVR
Cisco IP IVR is an IP-powered interactive voice response application that 
provides an open and extensible foundation for the creation and delivery of 
IVR solutions via Internet technology. It automates the handling of calls by 
autonomously interacting with users. 

IVR
See interactive voice response.

– L –

LAN
See local area network.

Launch External Application action
An action that starts an external application from within Agent Desktop. 

LCC
See logical contact center.

LDAP
See lightweight directory access protocol.

License Administration
The application used to update the number of seats purchased in a user’s 
Desktop Product Suite. 
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lightweight directory access protocol (LDAP)
LDAP defines a standard manner of organizing directory hierarchies and a 
standard interface for clients to access directory servers. 

local area network (LAN)
Two or more computers, and other devices, connected by cable, generally 
within the same building or campus.

local extension
See extension.

logical contact center (LCC)
The root of the Directory Services tree where Desktop Product Suite 
applications query for information. It is used to segregate logically separate 
call centers within the Directory Services server.

Login/Logout button
One of the Agent State buttons on the Agent Desktop interface. It is used to 
log the agent in or out of the ACD system.

– M –

macro
A series of prerecorded commands that accomplish a task. 

macro hot key
In Desktop Administrator, the key used to pause the recording of a macro and 
to display the macro recording menu.

macro recorder
The feature in Desktop Administrator used to record a macro.

Make Call button
One of the call control buttons on the Agent Desktop interface. Clicking this 
button displays the dial pad so that the agent can make a call or use the 
phone book.

marquee message
A message the supervisor can create to scroll continuously across agents’ 
Call/Chat windows for a set length of time to communicate important 
information.
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Normal
A display mode in which the interface appears when calls are present and 
minimizes when idle.

– O –

outside line access code
The access code or series of touch tones that tells the switch that the 
following numbers identify a phone number outside the switch.

– P –

pane
Section of an application window.

password
A series of alphanumeric characters required to log onto an application or 
server.

PBX
See private branch exchange.

phone book
In Agent Desktop, any one of the stored phone directories. Agent Desktop 
contains global phone books as well as a personal phone book.

PIM
See protocol independent multicast.

plain old telephone service (POTS)
The basic service supplying standard telephones, telephone lines, and 
access to the public switched network. 

port
See IP port.

POTS
See plain old telephone service. 

primary server
In a duplex environment, the main server used. If the primary server fails, the 
secondary server takes over.
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private branch exchange (PBX)
A private telephone network used within an enterprise. Users of the PBX 
share a certain number of outside lines for making telephone calls external to 
the PBX. 

protocol independent multicast
Multicast routing architecture that allows the addition of IP multicast routing 
on existing IP networks. 

PSTN
See public switched telephone network. 

public network
A network operated by common carriers or telecommunications 
administrations for the provision of circuit switched, packet switched, and 
leased-line circuits to the public.

public switched telephone network (PSTN)
Refers to the world’s collection of interconnected voice-oriented public 
telephone networks, both commercial and government-owned.

– R –

Recording and Statistics server
A server program that logs agent state changes, calls, and records 
conversations.

Ready button
One of the Agent State buttons on the Agent interface. It is used to put the 
agent into the Ready state (ready to receive calls).

real-time transport protocol (RTP)
An Internet protocol for transmitting real-time data such as audio and video.

recent call list
A list of an agent’s 100 most recently made phone calls, automatically kept 
on the Dial Pad screen. 

Ringing event
The event that occurs when the phone rings. See Event.

RTP
See real-time transport protocol. 
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rule
A rule is a set of 1–3 data field conditions. If any or all the conditions that 
constitute the rule are evaluated as true, then the rule is met. Rules that are 
met trigger events and actions.

Run Macro action
An action that starts and runs a macro.

– S –

screen pop
The delivery of caller-specific information onto the agent’s computer screen 
(“populating” the screen).

seat
An instance of Agent Desktop, Supervisor Desktop, or other Desktop 
Product Suite applications. A customer purchases a license for a number of 
seats.

secondary server
In a duplex environment, the backup server. If the primary server fails, the 
secondary server takes over. 

shortcut key
A keyboard key or key combination (also known as a “hotkey” or “keyboard 
accelerator key”) that invokes a particular command that is generally faster to 
use than clicking the mouse through a menu. 

Shutdown event
The event that occurs when Agent Desktop shuts down. See event.

skill
An ability (expertise in a particular type of software, fluency in a foreign 
language, for example) of a call center agent. Calls can be routed based on 
agent skills (skill-based routing) for better customer service. 

soft phone
A software phone, such as Agent Desktop’s dial pad. 

Startup event
The event that occurs when Agent Desktop starts up. See event. 

status bar
The area on the Agent Desktop interface that displays the status of a 
selected call and any messages generated by the software or hardware. 
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Stealth
A display mode in which an application appears as an icon in the system tray 
unless maximized by the agent.

suite
A collection of software tools.

supervisor
The leader and/or manager of a team of agents.

Supervisor Desktop
The application used by contact center supervisors to manage agent teams 
in real time.

– T –

task button
One of a series of up to 10 buttons on the Agent Desktop interface to which 
actions can be assigned. 

team
A group of agents who report to the same supervisor.

threshold
The acceptable amount of time a call can remain at a particular device or call 
center. Caution or warning icons are displayed in the Enterprise Data window 
when thresholds are met or exceeded for a call. 

touch tones
See dual tone multi-frequency. 

transfer
A phone switch feature that allows moving a call from one extension to 
another.

Transfer button
One of the call control buttons on the Agent Desktop interface. Clicking this 
button displays the dial pad to transfer the call.

transfer, blind
A transfer in which the active call is transferred to the third party without 
ensuring that the transfer is successful (picked up at the other end).
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transfer, supervised
A transfer in which you speak to the third party to whom the call is being 
transferred before connecting the active call, in order to confirm that the 
transfer can be made successfully.

– U –

UDP
See user datagram protocol. 

user datagram protocol (UDP)
A part of the IP protocol suite. It was created to provide a way for applications 
to access the connectionless features of IP. It provides for exchange of 
datagrams without acknowledgements or guaranteed delivery.

user ID
An identifier that designates a particular user and that is required to log into 
an application or server.

user interface
An application’s look and feel to the user. 

– V –

virtual private network (VPN)
A network created by renting or acquiring some part of someone else’s 
network (a phone company, an Internet provider) and used to communicate 
between a company’s offices.

voice gateway router
A combination of hardware and software that links a POTS telephone 
network to an IP data network. 

voice monitoring
The ability of a supervisor to monitor an agent’s phone conversations without 
being heard and without letting the agent knowing it is happening.

voice-over IP (VoIP)
A category of hardware and software that enables people to use Internet 
protocol as the transmission medium for telephone calls.

voice packet
A digitized sample of a voice conversation sent over a network.
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voice response unit (VRU)
The computer used to interact verbally via a telephone with a caller. The 
computer plays announcements and questions to the caller, and the caller 
replies by entering information via touch tones, a rotary dial, or by speaking. 
“VRU” and “IVR” are often used interchangeably. See interactive voice 
response (IVR).

Voice-over IP Monitor server
A server program used to enable supervisors to silently monitor agents. 

VoIP
See voice over IP.

VPN
See virtual private network.

VRU
See voice response unit.

– W –

wild card
Special characters used to represent one or more characters in a string. An 
asterisk (*) represents several characters and a question mark (?) represents 
a single character.

window behavior
A feature that allows the user to control how the Desktop Product Suite 
application window acts on screen. See Always on Top, Keep Open, Normal, 
and Stealth. 

work flow
A sequence of actions that takes place when specific event/rule criteria are 
met. 

work flow group
A group that shares a common set of work flows. 
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